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VERICUT 7.1
Release Notes
December 29, 2010

VERICUT 7.1 Enhancements
Highlights
As of V7.1, VERICUT is no longer supported on UNIX. A UNIX computer can still be
used to run the VERICUT License Server program.
Support is added for the simulation of 6-axis Cartesian arm industrial robots (Fanuc,
Kuka, ABB, Kawasaki, Motorman, etc.). Support includes support for additional
"external" axes such as a robot on a linear axis or a part on a rotisserie axis.
A new feature, Initialization Files, is added to simplify the initialization of variables. An
Initialization File is processed at the same time as the "Start of Processing" event.
VERICUT supports three types of initialization files: Setup Initialization Files, Machine
Initialization Files, and Control Initialization Files.
A new feature is added for VERICUT collision checking: stopping the simulation at the
"exact" collision point between the machine components. While simulating an NC block,
VERICUT stops in mid-motion at each collision point. Clicking Step continues
simulation to the next collision point (or to the end of the motion if no more collisions
exist).
A new feature, Import CAD Tool, is added to the Tool Manager enabling you to import
CAD solid models of inserts and holders into VERICUT. Currently only CATV5
CatProduct and STEP AP 213 models are supported.
Tool Manager is enhanced to enable the creation and display of coordinate systems, as
well as use the coordinate systems to align tool components.
An unlicensed VERICUT Reviewer tool is added and intended to be used in the shop by
the machine operator. The VERICUT Reviewer enables you to quickly and easily view,
replay a previously processed VERICUT Project file. The VERICUT Reviewer does not
allow anything to be saved from the view-only session. The VERICUT Reviewer can be
accessed both as a stand alone tool outside of VERICUT as well as inside of VERICUT.
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Enhancement Details
CAM Interfaces
The CATIA V5_to_VERICUT Interface (CATV5) is enhanced to enable selecting a
profile in CATIA and passing it through to VERICUT to be used as a Solid of Revolution
(SOR).

G-Code Processing
A new Okuma control type is added to support Okuma block goto/labels defined as
alpha-numeric. By setting the control to be of type "Okuma", the declaration of a
subroutine, the declaration of a label, and then branching to a label will no longer
produce incorrect "word not defined" error messages.
The Siemens Sin840D control can be configured to read Siemens syntax MCD files as
well as Fanuc syntax MCD files. The parameter R can be either a variable tag or a macro
code. VERICUT is enhanced to support this dual function.
New macro, SubroutineParsingOptions, is added to support the Siemens Sin840D
control's ability to use an "any-character-file-name-block", such as
S2R2_196_ROUGH_2-78_DP_SPF, as a subroutine call.
New macros EnableShiftOffsets and DisableShiftOffsets are added, and existing
macros EnableWorkShiftOffsets and DisableWorkShiftOffsets are updated to provide
more control over Shift 1, 2 and 3 offsets.
A new conditional, HeidCondLblWord, is added to support alpha-numeric Heidenhain
Labels. This function looks at the following value to determine if the value is string or
numeric, and adjusts the Word accordingly. This then allows for proper parsing.
HeidCondLblWord
On a Heidenhain control, the LBL word can either be followed by a quoted string, or
a number, or an expression which equates to a number. If the next (non space)
character is a double quote, then this conditional function will change the word to be
LBL_STRING, and the word type to be Macro. Otherwise, this function will change
the word to be LBL_VALUE, and the word type to be Macro. These 2 new words
must be defined in the control. The Word Sub Type will be picked up from the
corresponding entry in the table.
Argument CurSubName is added to the SetDynamicVars macro to enable the tracking
of the subroutine name/level that is current. This feature supports either numeric or text
type variables. If the variable is not defined, it will default to a text type variable.
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The GLCondPWord2 conditional function is enhanced to define P as a variable if it is
part of a LET TYPE II command to support G&L NPH8000M indexed parameters, PPnn,
variable-variable reference.
The RPCP logic, the Dynamic Work Offsets, and the WorkingPlane logic have all been
modified to use the orientation of the Attach component rather then the stock component
to determine the orientation. This allows for the fixture and stock to be rotated.

NOTE: Previously, the DynamicWorkOffset macro used the flag set by the
DynamicWorkOffsetsLocalCoord macro. Based on the above change, the
DynamicWorkOffsetsLocalCoord macro is now obsolete. Calling this macro will now
have absolutely no effect.
New macro Heid_FeedRate is added to support Heidenhain specific feedrates. It divides
the feedrate by ten when simulating in Inch and multiplies the OptiPath output by ten.
New function ISVAR is added to support the Siemens Sin840D ISVAR command.
New macro Ijk2AbcIgnoreLimits is added to support Siemens Sin840D commands like
A3=/B3=/C3= IJK 5ax solution to not use Travel Limits.
Support is added for the NUM G76 command (write in a file) in Num 1060 controls.
G-Code Table logic is enhanced such that if the desired Table/Row is not found on the
project side, VERICUT will automatically look for the desired Table/Row on the
machine side.
An error is now output when a shared component is moved by more than one subsystem.
A new macro, LockAxisOnOff, is added to lock/unlock a specified axis. An error is
output if a locked axis is moved.
A new feature, Initialization Files, is added to simplify the initialization of variables. An
Initialization File is a text, or subroutine, file used to initialize various types of variables
used during simulation processing. An Initialization File is processed at the same time as
the "Start of Processing" event. VERICUT supports three types of initialization files:
Setup Initialization Files, Machine Initialization Files, and Control Initialization Files.
A Warning message is now output when an E Num variable is not supported.
Num System Variables are now displayed in the Variables window for NUM type
controls. They are listed under the appropriate Subsystem name.
VERICUT is enhanced to check the current feedrate against the Fast Feed setting
regardless of whether Feed/Revolution (FPR) or Feed/Minute (FPM) is being
programmed for turning operations. VERICUT uses the Spindle Speed to convert FPR to
FPM before comparing the value with the Fast Feed setting.
A new Conditional word, HeidCondLessThan, is added to support a Heidenhain 530
control using "LT" with "APPR LT" for a linear tangential approach move.
A new feature, Update Each Block, is added to the Variables window: Utilities menu.
This feature toggles on/off to specify whether or not the variables in the Tracking
Variables list are updated as each block is processed.
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A new macro, MeasureSystem, is added to enable specifying the coordinate system that
is to be used to transform the contact point generated by the Probe and Touch macros.
The point data is transformed to the specified coordinate system before it is saved in the
NC variables assigned by the Probe/Touch macro.
The Machine Offsets window is enhanced to enable displaying the Working Plane
Matrix.
A new "Generic" sync method has now been added to support for Mazak type syncing
with alternate syntax. With this method, the channel tags ("&F=/USER/PATH1/") are
user defined.
The RPCP, the Dynamic Work Offsets, and the WorkingPlane logic have all been
enhanced to use the orientation of the Attach component rather then the stock component
to determine the orientation. This allows for the fixture and stock to be rotated.
Siemens functions CFTCP, CFC, CFIN are now supported in the library Sin840D contol.
Support is added for Siemens Sin840D Grooving Cycle 93 commands CONTPRON,
EXECUTE, EXECTAB and INTERSEC.
New macros ToolChangeAlphaMachineSubroutine and
ToolChangeMachineSubroutine are added.
When the ToolChangeMachineSubroutine macro is called (with M6 for example),
VERICUT will search for a subroutine named "ToolChange" in all subroutine lists
(Project Tree, Machine Settings window, Advanced Control Options window, in that
order). As soon as a subroutine named "ToolChange" is found, then the subroutine
will be executed.
The ToolChangeAlphaMachineSubroutine macro is identical to the
ToolChangeMachineSubroutine macro, except that it uses the Tool ID set by the
macro ToolCodeAlpha. When this macro is called (with M6 for example),
VERICUT will search for a subroutine named "ToolChange" in all subroutine lists
(Project Tree, Machine Settings window, Advanced Control Options window, in that
order). As soon as a subroutine named "ToolChange" is found, then the subroutine
will be executed.
New macro, RotaryAxisLock, is added to support ORIVECT on an ACB type machine
(AC on the tool side, and B on the part side). RotaryAxisLock is used to lock rotary
component for ijk2ABC conversion only. Type 99 conversion is enhanced to ignore any
locked rotary axes but apply its current positions to support these types of machines.
Macro Heid_PolarIncAngle is enhanced to support polar linear interpolation.
New macro ReferencePointDirect is added to support OKUMA Machine Reference
Point commands.
A new function, Sign, is added to support the Heidenhain 530 "SGN" command.
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Machine Simulation
Machine Simulation now uses the Near Miss value when checking for collisions between
tool and stock.
Machine Simulation now does collision checking between two cut stocks, including using
the Near Miss value for situations such as when the stock comes from the main spindle
and is cut off for additional operations on the sub-spindle.
A new feature is added for VERICUT collision checking: stopping the simulation at the
"exact" collision point between the machine components. The new feature is turned
on/off using the new Stop At Collision check box on the Start/Stop panel.
The new logic is applied ONLY to the Machine Simulation collision checking, and
ONLY to machine components other than the STOCK component. It is not applied to the
holder/stock and tool/fixture collision checks done from the material removal logic.
While simulating an NC block, VERICUT stops in mid-motion at each collision point.
Clicking Step continues simulation to the next collision point (or to the end of the motion
if no more collisions exist).
A new Subroutines tab is added to the Machine Settings window to enable saving
Machine subroutines in the Machine File.
Near Miss checking now ignores the shank portion of the tool. Collisions involving the
shank portion of the tool are still reported.

Tool Manager
The ability to align tool components using coordinate systems is added.
The ability to create and display coordinate systems in the Tool Manager is added.
A new feature is added to the Tool Manager, File menu > Import > CAD Tool displays
the CAD Geometry window enabling you to import CAD solid models of inserts and
holders into VERICUT. Currently only CATV5 and STEP models are supported.
The Set Spin Center feature has been implemented in Tool Manager's Tool Display right
mouse button menu, and can be viewed and turned on/off using the Tool Manager View
Orient window.
A new feature, Shift Component Z, in the tool component right mouse button menu
enables you to quickly shift the component in the Z direction. The window that displays
also supports simple math expressions, such as 1+1 and will shift by 2.
VERICUT is enhanced to enable switching between a "primary" and an "alternate" cutter
shape, in order to support tools such as back-boring tools. See "Create and Use Tools
with Alternate Cutters", in the VERICUT Project Tree section of VERICUT Help for
complete information.
Support is added for referencing tap, knife, probe, and water jet cutter tools and
assemblies.
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A Recent Files option is added to the Tool Manager File menu providing a list of
recently used tool library files.
The prompt "Do you want to delete the selected tool record?" is now displayed to
confirm deletion when deleting a tool record in Tool Manager using the keyboard
"Delete" key.

Verification
The following enhancements are added to the Project Tree:
•
•
•
•
•
•
•
•

A shortcut Toolbar is added to enable you to quickly go to a particular Project
Tree branch. Hold the cursor over the icons to see what branch the icon goes to.
Model file names are now shown in parenthesis for all models that have model
files associated with them.
General purpose Undo/Redo buttons are added to the top of the Project Tree.
Double clicking on an NC Programs, or NC Subroutines, branch now displays the
appropriate file selection window.
An Add NC Program File option is added to the NC Programs branch right
mouse button menu.
An Add NC Subroutine File option is added to the NC Subroutines branch right
mouse button menu.
The NC program that is currently being processed is now displayed in blue text
and is highlighted with a blue background.
A Collapse All Children option is added to all Project Tree branch right mouse
button menus that previously only contained the Expand All Children option.

•

Models can now be renamed give them descriptive names like "clamp"
"headstock", "jaw1", etc. The underlying file name of the model file is not
changed.

•

The parameters for model Types: Block, Cone, Cylinder are now displayed.

An unlicensed VERICUT Reviewer option is added and is intended for use in the shop
by the machine operator. The VERICUT Reviewer enables you to quickly and easily
view, replay a previously processed VERICUT Project file. The input to the VERICUT
Reviewer is a VERICUT Review file (.vcreview). The VERICUT Review file contains
all of the information required to replay the toolpath and machine simulation that was
created in VERICUT. VERICUT Reviewer does not allow anything to be saved from
the view-only session. VERICUT Reviewer can be accessed inside of VERICUT and
also accessed as a stand alone tool outside of VERICUT.
A new feature, Assembly, in the Open model file selection window enables you to
extract all the individual components of a STEP file and store them in their own model
definitions. If Assembly is toggled "on" (checked) a separate model will be created for
each component in the STEP file. When toggled "off" (unchecked) all components are
used to create a single model. This feature currently only supports STEP models.
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Drag & Drop functionality is added to the View Toolbar window (View menu >
Toolbar), the NC Program file selection window (double click on the NC Programs
branch in the Project Tree) and the Variables window (Project menu > G-Code >
Variables).
The features of the Word/Address window and the features of the Advanced Control
Options window: Events tab are combined in a new G-Code Processing window
(Configuration menu > G-Code Processing).
A new Hide Menu feature enables you to hide individual items from a menu pull-down
list, hide an entire menu from the Menu Bar, or even hide the entire Menu Bar if you
choose. See "Customizing the Menu Bar" in the Getting Started section of VERICUT
Help for complete information.
The Status window is enhanced to enable viewing cutting conditions while stepping
through the NC Program. The Record Cutting Conditions feature in the File menu >
Properties window must be toggled "on" for the values to be displayed in the Status
window when OptiPath is not active. This feature is only valid for jobs that could
normally be optimized using OptiPath.
Starting a new project now opens a dialog that prompts you for new project settings and
enables you to specify the name of the new project. VERICUT now prompts you to save
the project file if you close it without doing so.
The VERICUT Log File tool summary table now displays the length of the tool that
extends from the holder as "Cutter Stick Out". In the case where there is no holder, such
as with an APT tool from an NC file, the length of the cutter is displayed instead.
VERICUT is enhanced to support keyboard shortcuts that mimic Windows text-editing. It
now supports up/down/left/right arrow keys, home, end, page up, and page down with
control and/or shift modifier keys. See "NC program Editor", in the VERICUT Project
Tree section of VERICUT Help for details.
The ability to reverse the Profile view around the Z-axis and/or the X-axis is added.
Indicators like those used in the Call Stack window are added to the NC Program window
(Info > NC Program) to indicate "sync" status.
VERICUT now ignores cutter/fixture collisions when "OK to Cut Into Fixture" is
toggled "on", the tool is in "rapid" mode, and the tool retracts from the fixture along the
tool axis.
Debug messages output during a "Scan" pass are enhanced to include the line#, filename,
subroutine, and subsystem.
The error message output when trying to open an IP file created with another version of
VERICUT is enhanced to show the VERICUT version that the IP file was created in.
A 2D coordinate system can now be displayed in a Profile view.
The MDI window now keeps settings for the duration of the current VERICUT session.
The subsystem, axis, and resolution settings are stored for the current VERICUT session.
If you open an existing project, or create a new project, the settings will be initialized.
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Saving IP files or saving the project files does not keep the previous settings when
opened in another VERICUT session.
Right mouse button menus are enhanced to provide a scrolling capability for menus
containing a large number of items.
NC Program Review is enhanced to update the Status window while stepping forward
and backward.
NC Program Review is enhanced so that a single click on error will set the "Current"
location.
AutoSave > View Capture > Auto Error is enhanced to enable specifying the number of
images to save for a specific event (Start of File, Tool Change, etc.).
The Spin Center markers and CSYS rotation markers are now visible in OpenGL views.

Miscellaneous
Subroutine controls like the Step/Subroutine Options found in the VERICUT main
window that enable you to specify how you want VERICUT to handle subroutines is
added to the MDI window enabling you to "step over", "step into", or "step out" of
subroutines.
When an error occurs in an NC block in the MDI window, the error message to the
Logger now reflects the block in the MDI window and not the "current" block in the NC
program.
The following enhancements are added to VERICUT Reports:
•
•
•
•

The ability to create links to a file or web address is added.
A graphical representation of the output for a VERICUT report template is added
to the Report Template edit window to assist in determining which report
template feature produces what output in the report.
VERICUT Reports now supports nested tables, and pictures in tables, which can
also be used for table cell merging.
An option (Text > Process Data > Setup Name) is added to add Setup Name to
VERICUT reports.

Helical milling material removal is enhanced by creating by creating a "true helix"
motion type.
The OPTI Status light now displays yellow when a VERICUT-OPTIPATH ON/OFF
comment command suspends optimization and green when a VERICUT-OPTIPATH
ON/OFF comment command re-activates optimization.
Diameter value is added to hole measurement information in X-Caliper.
The old Using VERICUT topics are starting to be updated and incorporated in the
appropriate sections of VERICUT Help.
Heidenhain functions INT and FRAC are now supported in the library Hei530 control.
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NC Program Preview is enhanced so that gouges detected by Constant Gouge Check are
now graphically selectable for interrogation.

Problems Resolved in V7.1
CAM Interfaces
Right-clicking on an NX7.5 operation and selecting "ToolPath" > "Verify" now displays
the NX Toolpath Visualization dialog box instead of the NX_to_VERICUT Interface
window.
Tools in NX parts created in pre-NX 7.5 versions are now successfully transferred from
NX 7.5 through the NX_to_VERICUT Interface to VERICUT.
When using the ProE_to_VERICUT Interface with a Template file that uses an encrypted
machine file, the Stock, Fixture and Design can now be picked either by search or from
graphical pick from the Window. You can also now set the "From" component when
trying to set up the Work Offsets.
The Cut Stock orientation is now correct when using multiple setups with the
ProE_to_VERICUT Interface.
The ProE_to_VERICUT Interface no longer ignores the proev_v7.0_user.prefs file
settings after closing and then re-opening the interface.

G-Code Processing
Component visibility is now correct when using macro SetComponentVisibility ORV: 0
before and ORV: 3 after motion.
Values for G57 Work Offset now are correctly displayed as FRAME ARRAY values in
the Variables window.
By setting the control to be the new type "Okuma", the declaration of a subroutine, the
declaration of a label, and the branching to a label will no longer produce incorrect "word
not defined" error messages.
The "W" offset is now correctly updated when the part rotates when associated with
relational offsets, dynamic work offsets, and non XYZ components.
Appropriate error messages are now output for Siemens REPEAT commands when a
label is misspelled or missing.
The Siemens CYCLE 95, VARI parameter (9th param.) now works correctly for
Transverse Roughing.
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False "Holder ... exceeded near miss tolerance ..." errors are no longer output for a
specific holder during circular motions.
Incorrect values are no longer returned when the names of the variables on the call to the
sub are the same as the variable names used in the sub declaration, except that the
variables in the call to a sub are listed in a different order.
The correct IJK vectors are now calculated when a specific PROC is used with the
ORIVECT command.
Invalid "Update the 6.x control file to 7.0...." warning messages are no longer output
when doing a Save All with encrypted control files. This has also been corrected for
encrypted machine files.
A Fanuc G72 Cycle Turn Rough Facing cycle now processes correctly for a specific
project file.
A Num 1060T G64 Rough Face Turn cycle now processes correctly for a specific project
file.
A specific Type=Special, SubType=Begin Data, word format used in a specific multiple
setup project file now processes correctly.
A problem causing a B0 command, in a specific project file with B-axis EIA, Shortest at
360, to move 360 degrees when it should not move at all is fixed.

Machine Simulation
Models attached to a motion component attached to a Spindle component now spin
correctly.
A new broaching method in V7.1 is implemented to replace failure prone work-arounds
used in previous versions to simulate broaching.
Spindle direction checks are now correct for instances where any part of the insert crosses
the turning centerline.
Spindle direction checks are now correct for instances where a turning stock is cut with a
milling tool.
Assigning a value to a variable using a subroutine, for a specific project file, now
produces the correct motion as it did in earlier VERICUT releases.
The radius is now formed correctly when cutting with a specific groove tool that uses a
concave insert.
An MDI Move to Pick Location no longer causes the Design model to become invisible.
Processing no longer continues after machine animation stops for a specific project file.
When the AlternateTool macro is "on" and if no alternate tool is indicated, VERICUT
now displays the primary tool.
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Invalid collision errors are no longer output when simulating a specific project file with
the Animation Slider set at 100% or in the Skip Motion range.
The MDI window now keeps settings (SubSystem ID, Axis, and Jog Distance) for the
current VERICUT session. If you open another project, or create a new project, the
settings will be initialized. Also, VERICUT does not keep the previous settings after
saving an IP file or saving the project file since those actions are considered to be
opening another session.
The MDI window no longer goes dim/gray after a Collision or Travel Limit error
condition.
VERICUT now outputs an error if the specified block skip switch is invalid.

OptiPath
The Status window now shows the correct feedrate while optimizing.
Using Circle Feedrate = Programmed, Breakup, etc. in OptiPath, no longer results in the I
and J values being incorrectly changed during optimization.
Chip Thickness is now displayed in the Status window during optimizing with OptiPath.
A new macro, Heid_SpindleFormat, is added to provide the ability to include the Tool
Number in a TOOL CALL command in the OptiPath output as required by certain
Heidenhain conversational controls.
A new macro, Heid_FeedrateFormat, is added to provide the ability to not include R
and M codes in the command line for the initial tool in the OptiPath output as required by
certain Heidenhain conversational controls.
OptiPath now outputs the correct number of decimal places when optimizing a CATIA
APT file.
A new macro, OptiNotExceedProgFeed, is added to enable the option of not exceeding
the programmed feedrate in the OptiPath output.
The OptiPath Time shown at the end of OptiPath processing and the OptiPath Time
reported from running the Optimized NC Program are now consistent.

Tool Manager
Cutter Diameter is now correctly output to VERICUT Reports.
Turret Setup window > Position > Assemble tab: Mate/Align Offset no longer resets to
zero.
Modifying a Driven Point, using the Insert Cutter window: Tool Component tab, no
longer causes the Driven Point ID to change.
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The Gage Point is now updated correctly after editing a holder when Automatic Gage
Offset Z is turned on.

Verification
Adding a component in the Project Tree no longer causes all collapsed branches in a
setup to expand.
A problem that resulted in invalid holder collision being reported when a V6.2.2 project
file was opened in V7.0.3 is fixed in V7.1.
VERICUT Solid (.vct) models now display correctly after changing Visibility from not
visible to visible and then rotating the display.
A false spindle direction error is no longer output for a specific tool having 2 SOR cutter
components.
Processing time for Tool Holder/Stock and Tool Holder/Fixture Collision Checking when
using STL holders has been greatly reduced.
The Volume Removal Rate shown in the Cutting Conditions Graph for a specific project
file is now consistent regardless of whether OptiPath is turned on, or off.
Processing time for Holder/Stock Collision Checking when using very large STL holders
has been greatly reduced.
False collision errors are no longer reported when using very large STL holders during
grooving operations.
A profile cutter's shape is no longer changed when Minimum Cutter Extension is turned
on during plunging motions with a specific cutter.
TurretToolChangeByNumber and TurretToolChangeAlpha now output error messages
when the specified tool number is not found.
Changing the Animation Speed Slider setting no longer affects tool shank/stock collision
detection for a specific project file.
The Info > NC Program window now displays a single NC program correctly when
simulated on a multi-channel machine.
All stock models now display correctly for situations where the cut stock from the first
setup is transferred to the second setup which already has another stock model.
Model "Inherit" color now shows the parent color, so you know what color the "Inherit"
option will give you.
If a turret position does not contain a tool, and the turret is indexed to that position,
VERICUT no longer continues to use the previous tool, but outputs an error message
instead.
VERICUT now displays the red "busy" light while an In-Process file is being saved.
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A G72 Rough Face Cycle in a specific project file now correctly shows the roughing
passes.
The ability to modify, or mirror, a cut stock has been removed in V7.1. The Stock model
should be modified, or mirrored, instead.
Collision Volume values are now consistent whether viewed in the Logger collision error
message, or analyzed in X-Caliper.
False tool/fixture collisions, when OK to Cut into Fixture is active, are no longer reported
for a specific 5-axis project file.
A problem causing long delays when "Open ..." file selection windows are used for the
first time on Vista and Windows 7 computers is fixed.
Unexpected VERICUT termination no longer occurs when recording a VERICUT video
(vericut.img) with OpenGL turned on.
False Fast Feed errors are no longer output when the VERICUT simulation is set to Stop
at Tool Change for a specific project file.
An enlarged display of a turning Cut Stock, when it is spinning, no longer occurs when
the Animation Slider set at 100% for a specific project file.
An X-Caliper Hole Depth measurement that is successful in the 1st Setup of a specific
project file, no longer results in an error when the same Hole Depth measurement is taken
in the 2nd Setup.
Rotating a Workpiece view, with OpenGL turned on, no longer causes the display to go
blank for a specific project file.
The Calculate Min. Cutter Extension value is no longer applied to the wrong tool for a
specific project file that has 2 active tools.
VERICUT no longer executes an "Expand All Children" when pasting, or adding, a
component in the Project Tree.
A false collision error is no longer reported when the Animation Speed Slider is set at
100% for a specific project file.
Cutter to fixture, and Shank(Holder) to Fixture, collision areas are now correctly
displayed for a specific project file.
The Edit NC Program icon no longer opens the NC Program Editor when VERICUT is
paused in mid-motion.
VERICUT now displays the Save Control File file selection window when you try to
save a "Read Only" control file enabling you to specify an alternate name /location for
the control file.
Using a Sin840D Repeat command in situations where there is a second level/layer of
repeat with a second Repeat command, now works correctly.
Unexpected VERICUT termination no longer occurs for a specific project file.
An icon is added to the VERICUT Toolbar to access the G-Code Advanced Settings
window.
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Using a Relational Offset to define Work Offsets now works correctly.
Adding models to a component in the Project Tree are now displayed in the "inherit"
color of the parent by default.
Material removal is now correct for a specific project file.
Calculate Min. Cutter Extension now works correctly for a specific project file where
stock size is small compared to the tool size.
A G7 subroutine, in a specific project file, now positions correctly.
The Project Tree branches no longer expand when a Reset is executed.
False B-axis and C-axis collision errors are no longer reported when Skip Motion is set
greater than 0 for a specific project file.
The tool path trace is now correct for a specific project file when viewed in NC Program
Review.
False holder collisions are no longer reported for a specific project file that creates a
VERICUT Solid file from the cut stock in the 1st Setup and then uses the VERICUT
Solid as the stock in the 2nd Setup.
The image quality of a specific project file is no longer affected by changing the position
of the Animation Speed Slider.
Material removal is now correct for a specific project file using a facing head with tilted
inserts.
Material removal is now correct for a groove tool in a specific turning project file.
The Check Cutting Limits feature now works properly for APT source files in a specific
project file.
The spinning Cut Stock display in the Sub-spindle is now correct for a specific project
file.

Miscellaneous
The library Sin840D control has been updated so that probing works correctly.
The library Fanuc15m control is updated so that polar interpolation works correctly.
Editing the JPG image in a VERICUT report no longer causes the image to lose its
properties such as location and justification.
The value for the Calculation Tolerance is now correctly saved in an encrypted machine
and control files.
The pallet change for makino_mag3.VcProject, in the /samples/Makino/ directory, is now
correct. In 7.1 the "Disable Auto Direction" flag is replaced with a new "Part Side"
option, which can be set to "Auto" (default), "Yes", or "No". The part side flag is set at
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reset, and is no longer set as the connect macros are called to move the components
around.
NC Program Review and NC Program Preview now correctly display the tool path trace
for helical cuts.
Geometric Tolerance symbols now print correctly when creating an Inspection report in
PDF format.

New Macros in V7.1
The following new macros are added for V7.1.
ABCPos
BroachModeOnOff
CartesianModeOnOff
CGTechVarUpdateMacro
Cut3dcMode
CycleStepMode
CycleStepUpMode
CycleTurnReturnOnOff
DfixPrecisionIndex
DfupPrecisionIndex
DisableShiftOffsets
DroundPrecisionIndex
EnableShiftOffsets
GearModeOnOff
GetBlockString
GetCommentString
Heid_CutterCompOnOff
Heid_Feedrate
Heid_FeedrateFormat
Heid_PilotContourDef
Heid_PilotCycleTurnFinish
Heid_PilotCycleTurnRoughCut
Heid_PilotEndContour
Heid_PilotLimitInXDirection
Heid_PilotLimitInZDirection
Heid_PilotPilotHoleRef
Heid_PilotRecessing
Heid_PilotRecessingAction
Heid_PilotStartContour
Heid_PilotSurfaceDef
Heid_PilotSurfaceYDef
Heid_SpindleFormat
Ijk2AbcIgnoreLimits
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IncrementalDimensionMode
KnifeOnOff
MeasureSystem
NumSubSequenceOverWrite
NumVarUserDefined
OptiNotExceedProgFeed
PQRVector
ProcessCutterComp
ProjectUnitsVar
RapidRotaryTolerance
ReferencePointDirect
RotaryAxisLock
SetCutterCompVar
SetPostSubParameter
SetPostSubTextParameter
SetPostTapeTows
SetRobotBaseCsys
SetRobotCsys
SetRobotEndEffectorType
SetRobotMotionType
SetRobotRotisAxisMode
SetRobotTipCsys
SetRobotXAxisMode
SiemensCONTPRON
SiemensEXECTAB
SiemensEXECUTE
SubroutineParsingOptions
TangentialControlType
TapeProjectOnOff
TapeSetCourse
TapeSetNewLayer
TapeSetPlyAngle
TapeSetSequenceID
ToolChangeAlphaMachineSubroutine
ToolChangeMachineSubroutine
UpdateVariable
UpdateVariableBlockProcessing
XyzPos
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Macros not yet included in the documentation
CGTechVarUpdateMacro
Function — VARIABLES
Status — ACTIVE
Comments — Added V7.1
Valid Inputs — Text, Value
This is a replacement macro for the CGTechVarDefMacro in events. This macro will
work similarly to the DefMacro, except the variable must be pre-defined in the control.
As of this change, the CGTechVarDefMacro is not available to be added to the events.
You must pre-define the variables through the 'Control Variables…' window, and if you
want to have a value set at start of processing, you can use this new macro to do so.

NumVarUserDefined
Function — MISCELLANEOUS
Status — ACTIVE
Comments — Added V7.1
Valid Inputs — Text
This macro is used to specify the range of user defined variables in a NUM control. The
range of user variables should not overlap NUM system variables. The specified range
does not implicate the actual allocation of variables. Any user defined variable is created
when it is referenced in the NC program. The range is specified by Override Text in the
format "first last". For example 80000 99999 specifies that any variable from 80000 to
99999 will be considered as user defined.
Also see: NumEFunc function in the Configuration Menu section of VERICUT Help.

ProcessCutterCompRestore
Function — CUTTER COMPENSATION
Status — NOT RECOMMENDED
Comments — Added V7.1
Valid Inputs — None
Restores the cutter compensation setting to the value that was active prior to the last call
to ProcessCutterComp. If ProcessCutterComp has not been called since the last reset,
this macro will have no effect.
Also see: ProcessCutterComp

18

UpdateVariableBlockProcessing
Function — VARIABLES
Status — ACTIVE
Comments — Added V7.1
Valid Inputs — Text
This macro is similar to the UpdateVariable macro, except that it will only be used in
the following types of events: "Start of Block Processing" and "End of Block
Processing". Unlike the UpdateVariable macro, however, the variable associated with
this macro does NOT have to be pre-defined. It will auto create when there is no such
variable at the time this macro is called.
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VERICUT 7.1.1 Interim Release
Release Notes
January 18, 2011

VERICUT Version 7.1.1 is available for all supported Windows platforms.
V 7.1.1 contains everything described above for V7.1, plus the following additional
fixes/enhancements.

CAM Interfaces
The GibbsCAM_to_VERICUT Interface (GibbsV) now passes the correct tool Gage
Point to VERICUT.
The GibbsCAM_to_VERICUT Interface (GibbsV) now passes the correct file name for a
specific design model ply file and the file name called in the VERICUT project file.
The Mastercam_to_VERICUT Interface (MCAMV) no longer attaches the "current"
Csys to NC program files passed to VERICUT.
The NX_to_VERICUT Interface (NXV) is enhanced to enable specifying a tool file name
while in the NXV interface.
The NX_to_VERICUT Interface (NXV) now correctly positions the coordinate system,
when VERICUT is launched, for situations where VERICUT G-Code Table: Table Name
is set to Program_Zero.
The NX_to_VERICUT Interface (NXV) now correctly passes NC Subroutines to
VERICUT.
The NX_to_VERICUT Interface (NXV) is enhanced to include new feature Translate
Holder As to enable specifying whether to transfer an NX holder definition as individual
SORs for each step or as a single SOR representing the complete holder.
The NX_to_VERICUT Interface (NXV) is enhanced to include new feature Translate
Holder As Library Reference enable "referenced" tool holders to be passed to
VERICUT.
The NX_to_VERICUT Interface (NXV) now correctly orients the default Stock block
(no NX Stock model specified) in VERICUT.
The NX_to_VERICUT Interface (NXV) now correctly passes the coordinate system
specified by the VERICUT GCode Table entry for 'To' Csys to VERICUT when the
Transfer All Coordinate Systems option is toggled off.
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G-Code Processing
The Siemens TRANS U, V and W commands are now supported in the library Siemens
840D control (sin840d.ctl).
The Siemens OFFN command is now processed correctly by the library Siemens 840D
control (sin840d.ctl).
The library Siemens 840D control GEOAX PROC is enhanced to support cancelling
multiple GEOAX statements, or a single GEOAX statement, in the NC program.
CurStackLevel dynamic variable is added in macro SetDynamicVars, to enable
continuous tracking of the stack level of the subroutines for the NC program being
executed.
A specific project file using a drill cycle with G16 polar and G91 incremental now
processes correctly.
The WorkingPlane2AbcType macro now produces consistent results whether using
either Override Value= 2, or Override Value = 99.

OptiPath
OptiPath Learn Mode no longer calculates a bad Chip Thickness value for a specific NC
program file.
The OptiPath Savings Calculator, Optimized Time value and the Optimized Total Time
value shown in the VERICUT log file are now consistent.
The OptiPath Savings Calculator, Optimized Time and Percent Time Savings values are
now correct for a specific project file.
OptiPath no longer creates a toolpath with oscillating feedrates for a specific NC
program.

Tool Manager
A specific 7-parameter cutter is now created correctly when the flute length at the tangent
point of the angle and the shank.
Driven Point IDs that contain preceding zeros are now correctly processed by VERICUT.
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Verification
A turning cutter is now oriented correctly in a Workpiece view during CLS file
simulation for situations where the program origin is set 180 degrees around X direction
compared to workpiece origin.
The correct toolpath is now created when Curve Fit is used with large point to point NC
programs.
Large VERICUT Solid files (.vct) now load correctly from a network folder.
The Tool Summary Table report template is enhanced to include an NC Program field
containing file name for each tool.
Setting the Start, Current, or End markers in the NC Program Review, NC Program
Listing area no longer requires left clicking to indicate the line in the NC program and
then a right-click to display the menu to select the desired action. Now, just right-click on
the line in the NC program and select the desired action from the menu that displays.
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VERICUT 7.1.2 Interim Release
Release Notes
March 28, 2011

VERICUT Version 7.1.2 is available for all supported Windows platforms .
V 7.1.2 contains everything described above for V7.1.1, plus the following additional
fixes/enhancements.

CAM Interfaces
The CATIA V5-to-VERICUT Interface (CATV5) is enhanced to better handle bringing
in CATIA V5 Solids of Revolutions (SOR) into VERICUT. A more robust method of
detecting when an SOR can successfully be used, and which axis the sketch profile is
revolved around, is now used. If there is any question as to the ability of CATV5 to
generate the correct SOR, CATV5 will revert to creating an STL for that model.
The CATIA V5-to-VERICUT Interface (CATV5) is enhanced to include 3 extra
"refresh" buttons, one each above the Design, Stock and Fixture part lists. Clicking on
one of the buttons will wipe out the corresponding list and re-populate it with the set of
parts that CATIA would use for its video "simulation" capability.
The CATIA V5-to-VERICUT Interface (CATV5), used with CATIA V5 R20, now
correctly positions the Design model with respect to the Fixture models for situations
where the part origin is a long distance from the center of mass.
A specific T-Slot type tool created in CATIA V5 R19 is now correctly passed through the
CATIA V5-to-VERICUT Interface (CATV5) to VERICUT.
The CATIA V5-to-VERICUT Interface (CATV5) CATVFrench.local file is updated to
use the new Refresh button and the CSV Catalog Tool.
The GibbsCAM-to-VERICUT Interface (GibbsV) is enhanced to enable selecting
multiple NC Programs in the same way that multiple NC Subroutine files can be selected.
The Select NC Program and Generate NC Program tab labels in the GibbsCAM-toVERICUT Interface (GibbsV) main window have been replaced with icons. The
functionality remains the same.
The GibbsCAM-to-VERICUT Interface (GibbsV) now correctly transfers GibbsCAM
Custom Form tools through to VERICUT.
The GibbsCAM-to-VERICUT Interface (GibbsV) now correctly transfers GibbsCAM
Body Bag data with names containing Japanese characters.
The Pro/E-to-VERICUT Interface (PROEV) now works correctly when VERICUT is
installed in the default folder (C:\Program Files\CGTech\7.1.1\.).
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The Pro/E-to-VERICUT Interface (PROEV) now passes Pro/E solid model tools to
VERICUT.
The Pro/E-to-VERICUT Interface (PROEV) is enhanced to display the release date.

G-Code Processing
Loading pre-V70 controls directly into V7.1 will now automatically convert the controls
properly.
Unexpected VERICUT termination no longer occurs for a specific project file while
processing a Siemens 840d CYCLE800 command. The problem resulted from the use of
SetDynamicVars with a frame variable which was not supported. Support is added for
using SetDynamicVars with frame variables.
Invalid "Error: Invalid IJK value, vector can not be obtained." messages are no longer
output for a specific pre-V71 project file.
A specific subroutine now processes correctly when called from the MDI window.
A new macro, SiemensSetFrame, is added to enable copying one frame into another.
The SiemensWorkCoordIndex macro is modified to enable updating Work Offsets in
either relational or absolute mode.
The Fanuc G71 Turn Cycle is enhanced to enable processing Cutter Compensation.
Three new conditionals, QuoteCondBINWord, QuoteCondHEXWord, and
QuoteCondOCTWord are added to support converting numbers to all formats (Binary,
Octal, and Hexadecimal) used by supported Siemens 840D subroutines.
Support is added for variable STRING, variable STRING array, and alpha numeric words
for WORD/RANGE values, VARIABLE RANGE values, and for conditionals.
The DynamicToolTipOnOff macro now works correctly with Flash tool multiple driven
points.
Turn thread cycles now produce the correct "handed" thread when the Cut Stock is rotate
180 degrees about the Y-axis.
The TangentialMethod macro now works correctly when using an Override Value of 5
(Vertical) and there is no XY motion afterward.
False Rapid motion errors are no longer output when using the TangentialMovement
macro with an override value of 1 (Feed).
Fanuc G72 Turn Cycles in VERICUT no longer produce an extra final pass that does not
appear on the actual control.
Support is added for Siemens 840D "Indirect G-Code Programming".
Curve Fit - NURBS Fitting now works correctly when Control Type on the Control
Settings window: General tab is set to Siemens.
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New macros, ToolChangeIfDifferentMachineSubroutine and
ToolChangeAlphaIfDifferentMachineSubroutine, are added to enable calling the
ToolChangeMachineSubroutine and ToolChangeAlphaMachineSubroutine macros only
when the new tool id is different from the current tool id.
Macros ToolChangeMachineSubroutine and ToolChangeAlphaMachineSubroutine are
modified as follows:
ToolChangeMachineSubroutine has now been changed to call a subroutine named
"toolchange" rather than "ToolChange".
ToolChangeAlphaMachineSubroutine has now been changed to call a subroutine
named "toolchangealpha" rather than "ToolChange".
Number Variables that use an Override Text value are no longer incorrectly converted to
Text Variables.
A Number Variable with the Override Value left blank, no longer incorrectly converts the
blank field to a zero.
New macro, SetRobotElbow, is added to enable specifying the robot elbow position when
reading XYZ IJK positions.
Fanuc G72 Turn Cycle simulation is enhanced such that if the tool position resides inside,
or on, the contour extent, then a new motion point is inserted between the tool position
and the first point of the contour. The new motion point is determined by the following:
For Rough Turning
New motion point Z = first contour point Z coordinate.
New motion point X = last contour point X coordinate.
For Rough Facing
New motion point Z = last contour point Z coordinate.
New motion point X = first contour point X coordinate.
Step-over direction is now correct for a specific G72 Turn Cycle simulation.
Unexpected VERICUT termination no longer occurs for a specific V7.0 project file.
The Post Setup window (File menu > Convert >Post Processor) now remains in front of
the VERICUT window as data is entered in the Post Setup window's text fields.
The Post Set window can now be made smaller without hiding the features at the bottom
of the window.
The XyzPos and ABCPos macros are enhanced to accept an Override Text word
specifying the axis.
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Machine Simulation
Inserted milling cutters now spin correctly, in the in a Machine/Cut Stock view, when the
Gage Point offsets the tool assembly off of the spindle centerline.
The part transfer from the main spindle to the sub-spindle on a specific WFL millturn
machine once again works correctly.
Support is added for the Siemens 840D W Frame Transformation.
Support is added for the Siemens 840D DEF BOOL variable declaration statement.
Support is added for Siemens 840D functions INDEX and RINDEX.
A Tool to Fixture collision is now correctly detected for a specific multi-setup project
file.
A specific M20 Touch command in a V70 project file that uses a complex STL Cut Stock
now stops correctly.
Unexpected VERICUT termination no longer occurs when loading the library Siemens
840D control.

OptiPath
OptiPath no longer creates invalid circle records for a specific project file.
The OptiPath Feed value is now displayed correctly in the Status window.
A problem causing the Optimized Time value to be reported incorrectly in the Logfile,
Status window and in the OptiPath Savings Calculator is corrected.
OptiPath Learn Mode behavior is modified as described below:
1. When using Learn Mode, and no valid cuts for learning are detected, such as
during plunge milling motions, VERICUT will not create an OptiPath record for
the tool and will display the message "No valid optimizable cuts were detected for
tool nnnnn during learn mode, no OptiPath record is created."
2. OptiPath will, by default, update the optimization settings created during the
current Learn Mode session so that the record created will represent the worst
condition encountered in the whole NC program.
The "Output Number of Decimal Places" setting on the OptiPath Control window: APT
Output Options tab is now applied correctly when using OptiPath to optimize CATIA
APT NC program files.
Invalid errors are no longer output when optimizing CATIA APT NC program files when
OptiPath outputs additional lines to maintain the trajectory.
OptiPath Learn Mode no longer creates default OptiPath records for tools that are
skipped in the NC program and these skipped tools no longer appear in Optipath Reports.
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The OptiPath tool use time shown in the Tool Use Graph and the OptiPath Time shown
in the Status window are now more accurate.
False OptiPath warnings are no longer output for a specific project file when it is first
opened.
All machine components now display correctly in VERICUT Reviewer when the
reviewer file is created using an encrypted machine file.

Tool Manager
The probe tip no longer disappears when dragging and dropping a Probe tool inside of
Tool Manager.
The probe tip is now displayed correctly for "referenced" Probe tools.
Unexpected VERICUT termination no longer occurs when changing the Units in Tool
Manager.
Import > CAD Tool now works correctly when used in a stand-alone Tool Manager.
Importing a specific STEP tool insert using Import > CAD Tool, no longer causes the
VERICUT session to hang.
Importing a specific CatProduct tool insert, with a big complicated u-shaped insert face,
now displays correctly and removes material correctly in a Profile view.
The Configure Coordinate System: Rotate tab in Tool Manager is enhanced to support
Local Rotation the same as the Configure Coordinate System: Rotate tab in the Project
Tree.
The Configure Coordinate System: Translate tab in Tool Manager is enhanced to support
Local Rotation the same as the Configure Coordinate System: Rotate tab in the Project
Tree.

Verification
A problem causing unexpected VERICUT termination to occur under certain conditions
when the AutoSave:View Capture View Capture File text field is blank is fixed.
Unexpected VERICUT termination no longer occurs when processing helical motions for
a specific project file.
The VERICUT session no longer hangs up when you close the MDI window with the X
in the upper right corner of the MDI window.
A new Profile Sketcher feature, Create Inner Loop, enables creating "inner loops" within
the main profile when creating "swept" solid models. The "inner loops" will result in
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open areas in the "swept" solid model. This feature is not available when the Sweep
Profile window is accessed from Tool Manager.
False collisions are no longer reported between Stock and Holder when using a specific
concave bottom cutter with an unusual shape.
Using the Delete key on the keyboard to edit values in a table in the Machine Settings
window: Locations tab no longer results in the whole table being deleted.
Changes to graph range values are now saved correctly when the Graphs window is
closed.
Unexpected VERICUT termination no longer occurs when adding a model with the
AddModelToComponent macro.
False Tool/Fixture collisions are no longer reported when OK to Cut into Fixture is
active, Maximum Milling Depth set to a non-zero value and the tool axis changes.
The Project Tree, Side Icon Bar is enhanced so that you can double-click on one of the
icons and it will have the same effect as double-clicking on the item that a single-click on
the icon takes you to. For example, double-click on the Tooling icon in the Side Icon Bar
opens the Tool Manager window just the same as double-clicking on the Tooling branch
in the Project Tree.
A specific swept insert, created from an imported DXF profile, no longer misses cutting
a small radius cut.
The "hot key" shortcuts are now working correctly as they did in pre-V71 versions of
VERICUT.
The 3 "Subroutine" buttons now remain correctly aligned with the "Step\Subroutine
Options" button when "docked" Animation Controls window is resized.
VERICUT now automatically removes duplicate points when importing DXF profiles.
New conditional, ConstCondEXPWord, is added to support Siemens 840D's scientific
representation EX. This new conditional word type is used to differentiate between a
word specifying a variable or real number in scientific format/notation.
NullPointerException errors are no longer output to the Logger when browsing network
folders in VERICUT file selection windows on Windows 7 64-bit computers.
The file selection window that opens when the Add NC Subroutine Files button in the
Project Tree Configure NC Subroutines menu is pressed now opens in the Working
Directory.
VERICUT now correctly outputs a "Division by Zero" error for the calculations in a
specific subroutine file.
X-Caliper Feature/History now produces consistent results regardless of how the
Animation Speed Slider is set.
Material removal is now displayed correctly in NC Program Review regardless of the
Skip Cut setting.
The correct tool is now displayed in NC Program Review after doing a Rewind.
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Drill motions are now only considered valid if the motion is parallel to the tool axis.
Contact with material for any other motion with a drill results a collision error being
generated "Drill tool (num) contacts material during motion not parallel to the tool axis at
line: .......". All cutters defined using the "Drill" menu in Tool Manager are considered
"drills".
A false C axis clamp error is no longer output, for a specific project file that has both a C
and a C2 axis, when trying to move the C2 axis when the C axis is clamped and the C2
axis is activated.
The Control Variables window is now updated correctly when loading a specific multisetup project file.
Work Offset table values, modified using the Configure Work Offsets menu, are now
updated in the Project Tree immediately upon pressing Enter.
Unexpected VERICUT termination no longer occurs when Delete Detached Stock >
Update While Simulating and Replace Material When Stepping Backwards are both
active.
The Spindle Direction shown in the Status window is now correct for turning project
files.
File > New no longer sets the "library" folder as Working Directory for situations where
CGTECH_LIBRARY in the vericut.bat file is set to multiple paths.
The error message output when you assign a CSYS to a G-Code NC program is updated
to read: "Assigning a coordinate system to NC program file is not recommended for
machine simulation. Assign a Work Offset in the Project Tree instead".
Unexpected VERICUT termination no longer occurs for a specific turning project file.

Miscellaneous
Unreadable non-Japanese two-byte characters no longer appear in G-Code Reports.
The STL_OUTPUT command line option is enhanced in the following ways:
The "STLFIL=filename.stl" parameter is now optional. If the STL output file name is
not specified in the command line, it will use the one specified in the VCProject file.
The operation will fail if the output file is not specified in one of these places.
Parameter "STLTYPE=[value]" is added to enable specifying the STL output file
type. Use 1 for "STL" Type or 0 for "VERICUT" Type.
Parameter "STLREDUCE" is added to enable turning on "Reduce Triangle" mode so
the STL file will be created using the triangle reduction method.
The Polyfix Converter is enhanced to produce better results for situations where there are
redundant polygons in the model.
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A "Width %" Column is added in predefined tables (Tool Summary, File Summary,
View Capture, Inspection Features) to enable changing the width of the columns when
setting up a VERICUT report template.
An icon is added to the Toolbar for "Copy all files".
The orientation of Tool Thumbnail images in Tool Manager Report and Tool Summary
Tables in VERICUT Reports are modified as follows:
Turning tool thumbnails are displayed in the XZ plane.
All other tool thumbnails are displayed in the ZX plane.
Support is added for adding a Corner Radius in VERICUT Report and Tool Report
templates. This feature is only available for inserts and parametric APT cutters.
New feature "Tool Comments" is added in the Tool Summary Table and under Tool
Change Data to enable adding the content of the Comment field, for each tool in Tool
Manager, to be written out in the VERICUT reports.
A "preview" panel is added to the User Defined Tag Value window similar to the one
previously implemented for the Report Template window: Page Layout tab. The
"preview" panel is only available in HTML format.
HAAS/FANUC/Makpro/Mazatrol/Yaznak library controls now pass I/J/K/R variables
correctly for situations where a macro was called with any of these parameters on the
block, and the machine was in a circular motion state.
The following OptiPath related features are added, or renamed, in the Tool Summary
Table and under Tool Change Data for use in VERICUT Reports.
Tool Axial Depth, Tool Radial Width, Tool Maximum Spindle Speed, Tool Minimum
Spindle Speed, Tool Maximum Feedrate and Tool Minimum Feedrate
The above features are obtained from the OptiPath record of the tool.
Maximum Axial Depth, Minimum Axial Depth, Maximum Radial Width, Minimum
Radial Width, Maximum Spindle Speed, Minimum Spindle Speed, Maximum
Feedrate and Minimum Feedrate
The above features are calculated from the program for the given tool.
New features "Cutter Description" and "Holder Description" are added in the Tool
Summary Table and under Tool Change Data to enable adding the content of the
Description field, for each tool in Tool Manager, to be written out in the VERICUT
reports.
Colors can now be displayed in the Info > NC Program window in the VERICUT
Reviewer by clicking the palette icon or by selecting "Colors..." from the right-click
menu. Use the menu that displays to specify the colors. Colors will also now display
properly in the NC program window in VERICUT while in Review mode.
The VERICUT Reviewer Status window now correctly displays recorded Cutting
Conditions.
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The VERICUT Reviewer now steps back correctly when the last motion is a subroutine
call.
Unexpected VERICUT termination no longer occurs when processing a specific project
file with VERICUT Cutter Grinder.
The "probing_ding.wav" and "probing_dong.wav" files are added to "library" folder.

New Macros in V7.1.2
The following new macros are added for V7.1.2
ABCPos
EI_SafeMove
EI_SafeRetract
LockComponentOnOff
SetRobotElbow
SiemensSetFrame
ToolChangeAlphaIfDifferentMachineSubroutine
ToolChangeIfDifferentMachineSubroutine
TouchStockComponent
XyzPos

Macros not yet included in the documentation
ABCPos
Function — MOTION
Status — ACTIVE
Comment — Added V7.1.2
Valid Inputs — Text, Value
Sets the A, B or C angle values to define tool axis vector by RPY angles. The A, B and C
values are used to calculate tool vector for the next tool position. This method can be
used instead of using direct IVector, JVector and KVector macros defining components
of the tool vector and is specific for the KUKA robots. The tool axis vector can be
transformed to a user specified coordinate system.
See also SetRobotCsys macro.
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XyzPos
Function — MOTION
Status — ACTIVE
Comment — Added V7.1.2
Valid Inputs — Text, Value
Sets the X, Y or Z values to define tool position in Cartesian coordinate system. The
specified tool tip position is defined in the robot base coordinate system by default. You
can specify any coordinate system to transform the input position to the desired origin
and orientation using SetRobotCsys macro. Note that if the robot is tool tip programmed
using this macro the robot motion is assumed to be linear.
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VERICUT 7.1.3 Interim Release
VERICUT Composite Simulation Only
Release Notes
May 10, 2011

VERICUT Version 7.1.3 is available for all supported Windows platforms.
V 7.1.3 contains everything described above for V7.1.2, plus the following additional
fixes/enhancements.

VERICUT Composite Simulation
Enhancements
VERICUT’s Tool Manager is now added to VERICUT Composite Simulation.
A Sort Sequence option is added to the NC Programs branch right-mouse button menu in
the Project Tree enabling you to order all existing sequences under NC programs. Each
time Sort Sequence is selected, the sequence order switches between ascending and
descending order. It does not change the order of Ply Groups within a sequence, or the
order of NC programs within a Ply Group. The sorting logic compares number first and
then text string. A number is always considered smaller than a string.
The linear values in an MTorres .xml tow add/cut file are always read as millimeters.
Collision checking is enhanced to stop the simulation at the "exact" collision point
between the machine components. The new feature is turned on/off using the new Stop
At Collision check box on the Start/Stop panel.
The ability to save and use in-process files is added to VCS.
VCS checks to ensure that an ultrasonic knife blade is oriented in the same direction as
the cut. The knife definition in Tool Manager has a parameter Maximum Steering Angle
(default is 2 deg) enabling you to specify the acceptable deviation from direction of the
cut. If the knife orientation deviates from the direction of cut more than this tolerance, an
error is output to the logger and the cut trace is colored red.
The Color window: Assign tab (Edit menu > Colors) is enhanced to enable you to specify
a Course Edge color and a Tow Edge color.
A new component type, "Roller", is added to be used in place of component type "Tool"
to represent the part of a composite tape laying machine's head which presses tows onto a
form.
A new component type, "Form", is added to be used in place of component type "Stock"
to represent the surface upon which composite material is laid.
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A new Laminate Stack option is added to X-Caliper enabling you to determine the
composite material layers in the laminate stack, the ply direction of each layer and the
thickness of the laminate stack at a specified point.
Three new macros are added to course name, sequence ID and layer number so that they
will be displayed in X-Caliper.
TapeSetCourse is added to specify a name for a course so that it will display in the
X-Caliper results for features Information and Tow Packet.
TapeSetSequenceID is added to specify a sequence ID so that it will display in the
X-Caliper results for features Information and Tow Packet.
TapeSetNewLayer is added to specify a layer number. The layer in this context is
used for the color of the tape specified in the Color window and the "Layer :" values
shown in X-Caliper.
A new feature, Tow Packet, is added to X-Caliper to enable obtaining information
related to a "tow packet" selected in the graphics area. The "tow packet" is highlighted in
the graphics area and the following information is displayed in X-Caliper:
• min steering radius and graphically indicate where they are on the "tow packet".
• tows used, by number
• number of tow adds and cuts
• length of each tow
• total length of path from first tow add to last tow cut
The "Cut Stock" object in the Project Tree is replaced with a "Laminate object for
composite simulation.
New macro, TapeProjectOnOff, is added to enable turning On/Off the projection of tape
onto the form, or previous material surface, to support tape laying in the air, for example
when creating restraining bands.
The ability to simulate ultrasonic (panex) knife cutting, of the added composite material
model in VCS, is added.
The "current" NC program in the Project Tree is now displayed in blue text. The NC
Program is also highlighted in blue when it is actually simulating.
New macro, EI_SafeMove, is added to emulate the Electroimpact G110 subroutine on EI
composite tape laying machines.
New macro, EI_Retract, is added to emulate the Electroimpact G111 subroutine on EI
composite tape laying machines.

Problems Resolved
The C-axis now rotates in the correct direction when the rotary is set up as EIA Absolute
and Shortest Distance.
Using the G110 (EI_SafeMove macro) no longer causes the machine axes to move
beyond their travel limits.
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VERICUT Composite Programming
Enhancements
VCP is enhance to enable "batch" processing of multiple sequences/plies.
On the Ply card, writing a .VcPly file no longer requires that any courses exist. So
you can set all the parameters for a ply on the Setup and Ply cards, including the
selection of ply boundaries, cutouts and guide curves, then save them to a .VcPly file.
If you want to create a few courses to confirm that they are as expected, that's fine
too.
On the Zip/Unzip card, you would place all the .VcPly files into a zip, along with any
other files you might want, such as the .CATPart and SAT for the IML. On the same
card there are now 2 extra buttons, the first to process selected plies and the second to
process all plies. In the order that the .VcPly files appear in the card's table, top to
bottom, we do the following for each ply ...
1. Extract the .VcPly file from the zip if necessary
2. Read the .VcPly file, which will turn on boundaries, cutouts and guides,
provided their names are still valid.
3. Erase any links and courses that were in the file.
4. Fill the ply boundaries with new courses.
5. Generate safe restarts if there are any cutouts.
6. Write the revised .VcPly file.
7. Add the tow material to the form.
8. Write the revised SAT file.
After processing all the plies, the .VcPly files get refreshed in the zip file. If the zip
contained prior versions of the SAT files, they get refreshed too. Users should be
careful that the current form includes the correct layers' material at the start of the
batch process.
A new feature, Write one G-Code (and optional auxiliary) file per work packet, is
added to the Post card to enable posting multiple work packets at once and creating a
separate G-Code file for each work packet. Files are automatically named by appending
"_a", "_b", etc. for up to 26 work packets or appending "_001", "_002", etc. if there are
more than 26 work packets. When toggled "on" this feature also applies to "batch"
posting from the Zip/Unzip card.
A new feature, Use head path as link, is added to the Links card is added to enable
individually determining whether or not the head stays down between tow-packets when
tow-packets are not joined when they are initially created. Using this feature will cause
lead-in, run-out, retract, and all other Link card parameters to be ignored.
A new feature, Work folder "Browse" feature is added to the File card to enable
specifying a work folder (Working Directory). The selected folder gets remembered
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between sessions. It does not go into .VCP files, so is not associated with specific
projects.
A new feature, For each pick on a course, move the head path to the indicated side,
is added to the Flags card to enable moving the head path, one tow at a time, within a
course that uses less than the full complement of tows.
VCP is enhanced to enable specifying which tow positions should be used within a
course that uses less than the full complement of tows.
VCP is now supported on 64 bit Windows computers.
Each link between tow packets is now tagged with the numbers of the 2 tow-packets that
it connects. Use the Query selected link feature on the Links card to view the tow packet
numbers. Tow-packet numbers are only reported if the work-packet has been posted.
A new feature, Safe restart overlap, is added to the Setup card to enable specifying the
overlap required at each mid-course safe restart. The overlap value is applied during postprocessing.
The Roll center offset slider on the Post card is now one sided. VCP now determines
right or left automatically.
A new "Roller visualization" card, is added with features that enable the display of a
series of cylinders along a selected linked tow-packet, with "whiskers" representing the
"tool vectors". The features on this card enable you to specify the diameter of roller, the
degree of transparency of the roller and spacing of images.
The ability to butt-splice individual tows where they cross a selected curve is added.
A new Gaps card is added with features that enable you to specify tolerance values and
identify out of tolerance convergence areas.
A new feature, Long/short tows, is added to the Tow colors A/B pull-down on the
Colors card to enable identifying, and displaying, long and short tows.
VCP is enhanced to display the active coordinate system's axes with extended solid lines
on the positive side, and extended dashed lines on the negative side whenever a card with
a CSYS selection is raised. This feature is intended to assist in selecting the proper CSYS
for post-processing, linking, path creation, geometry creation, etc.
Long directory paths in the Recent files list are now truncated on the left and preceded by
"...\". The complete directory path can be viewed by holding the cursor over any row in
the list to display a "tip" with the complete path information.
New features, Show all axes and Hide current axes, are added to the Design card's Axes
tab to enable hide (blank) and unhide(unblank) coordinate systems. Use Hide current
axes to blank the currently selected coordinate system. Use Show all axes to show all
previously hidden coordinate systems.
New features, Lengthen by and Shorten by, on the Flags card enable extending, or
truncating, individual tows by a specified length.
The state of the Automatic reduction feature on the Ply card is now saved in the .vcply
file.
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Boundary, cutout and guide curve names are now passed to the post-processor, along
with flags that show the type of each curve. Note that a curve can be a combination of the
three types ... it could be both a guide and a boundary for example. The VcPost postprocessor can be set up include the curve names as comments in each MCD file header.
The formatting is done in a post routine called "PlyCurves".
The string variable "CSystem" is now available to post-processors and, when the "Modal"
subroutine is invoked, will contain the name of the coordinate system nominated on the
post-processor, laser or probe cards.

Problems Resolved
VCP can now check-out a CATIA V5 or STEP model interface license without the
license server having a "Verification" base license present.
Unexpected VCP termination no longer occurs when a Boeing .plydata file is read in the
Boeing trimmed surface field on the Form card by mistake.

Work Packet Sequencer (WPS)
WPS is enhanced to support the sequencing of four heads.
The ability to re-read all work packets in WPS is added by using the File >Refresh All
feature.
A new feature, Number, in the Sequence menu > New Sequence window enabling you
to specify a specific sequence number to be used in the Output Cell Script xml file.

CAM Interfaces
The NX_to_VERICUT Interface (NXV) is enhanced so that NX tap tools are passed to
VERICUT using the VERICUT Tap Tool definition instead of as a sketch profile.

G-Code Processing
New macro, BlockSkipNoValue, is added to support machine controls that not support
multiple switches. The Block Skip will always be interpreted as switch 1.
New macros, AutosetToolManCutComVars, AutosetToolManLengthVars, and
AutosetToolManDrvPntVars, are added to enable transferring tool data from Tool
Manager to specified control variables. AutosetToolManCutComVars is used to
automatically transfer Cutter Compensation data from Tool Manager to specified control
variables, AutosetToolManLengthVars is used to automatically transfer gage point data
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from Tool Manager to specified control variables and AutosetToolManDrvPntVars is
used to automatically transfer driven points data from Tool Manager to specified control
variables.

Machine Simulation
The informational message "Probe stem hit material before the probe tip" is now output
when the probe stem touches the part, instead of the probe "tip".

New Macros in V7.1.3
The following new macros are added for V7.1.3:
AutosetToolManCutComVars
AutosetToolManCutCom840DVars
AutosetToolManDrvPntVars
AutosetToolManDrvPnt840DVars
AutosetToolManLengthVars
AutosetToolManLength840DVars
AutosetToolManMisc840DVars
BlockSkipNoValue
CutterCompValueCombo
DuplicateLabelCheckOnOff
SetMinCollisionBreakDown
ToolLengthCompValueCombo
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Macros not yet included in the documentation
AutosetToolManCutCom840DVars
Function — VARIABLES
Status — ACTIVE
Comment — Added V7.1.3
Valid Inputs — Text
Override Text format: var_name
where var_name is the name of the 840D control variable.
This macro is used to automatically transfer Cutter Compensation data from Tool
Manager to specified Siemens 840D control variable. The variable name is specified in
the Override Text field and is usually $TC_DP15.
The variable should be defined in the .def file with a minimum size large enough to fit all
tools in the library and with the second dimension at least equal to the maximum number
of cutter compensation values of the particular tool. If the number of tools is larger than
the variable's first dimension, an error message is output in the logger. If the list of cutter
compensation values is larger than the variable's second dimension, all remaining values
will be ignored.
Example: Override Text value: $TC_DP15

AutosetToolManDrvPnt840DVars
Function — VARIABLES
Status — ACTIVE
Comment — Added V7.1.3
Valid Inputs — Text
Override Text format: var_name point_comp
where var_name is the name of the 840D control variable and point_comp is
the point component (X, Y, or Z).
This macro is used to automatically transfer driven point data from Tool Manager to the
specified Siemens 840D control variable. The variable name is specified in the Override
Text field and is usually $TC_DP12, $TC_DP13 or $TC_DP14.
The variable should be defined in the .def file with a minimum size large enough to fit all
tools in library and with the second dimension at least equal to the maximum number of
Driven Point values of the particular tool. If the number of tools is larger than the
variable's first dimension, an error message is output in the logger. If the list of Driven
Points is larger than the variable's second dimension, all remaining values will be
ignored.
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The point component X, Y or Z is specified as a second parameter in Override Text
field.
Usually $TC_DP12 is used for the Z component.
Example: Override Text value: $TC_DP13 X

AutosetToolManLength840DVars
Function — VARIABLES
Status — ACTIVE
Comment — Added V7.1.3
Valid Inputs — Text
Override Text format: var_name point_comp
where var_name is the name of the 840D control variable and point_comp is
the point component (X, Y, or Z).
This macro is used to automatically transfer gage point data from Tool Manager to the
specified Siemens 840D control variable. The variable name is specified in Override
Text field and is usually $TC_DP3, $TC_DP4 or $TC_DP5.
The variable should be defined in the .def file with a minimum size large enough to fit all
tools in library and with the second dimension at least equal to the maximum number of
Driven Point values of the particular tool. If the number of tools is larger than the
variable first dimension, an error message is output in the logger. If the list of Driven
Points is larger than the variable second dimension, all remaining values will be ignored.
The point component X, Y or Z is specified as a second parameter in Override Text
field.
Usually $TC_DP3 is used for the Z component.
Example: Override Text value: $TC_DP3 Z

AutosetToolManMisc840DVars
Function — VARIABLES
Status — ACTIVE
Comment — Added V7.1.3
Valid Inputs — Text
Override Text format: var_name data_type
where var_name is the name of the 840D control variable and data_type is
the keyword for the type of data to be transferred. The following data type
keywords are supported:
RADIUS - the tool's maximum radius
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TYPE -the VERICUT tool type (Default)
CORNER - the tool's corner radius
TOOLID - the tool ID
This macro is used to automatically transfer miscellaneous data from Tool Manager to
the specified Siemens 840D control variable. Currently supported are Tool maximum
radius (RADIUS), VERICUT Tool Type (TYPE or default), Corner radius (CORNER)
and Tool ID (TOOLID). The type of data is defined by a key word following the variable
name. The Tool ID string is stored in a one-dimensional string array. If the number of
tools is larger than the variable's first dimension, an error message is output in the logger.
The second dimension must be at minimum 1. For Tool ID the second dimension is not
required.
Examples: Override Text value: $TC_DP6 RADIUS
$TC_TP2 TOOLID
$TC_DP1
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VERICUT 7.1.4 Interim Release
Release Notes
August 12, 2011

VERICUT Version 7.1.4 is available for all supported Windows platforms.
V 7.1.4 contains everything described above for V7.1.2, plus the following additional
fixes/enhancements.

NOTE: VERICUT 7.1.3 was a VERICUT Composites Only release.

CAM Interfaces
The CATIA V5_to_VERICUT Interface (CATV5) is enhanced to output a Warning
message when it cannot adjust the model resolution with the Model Chordal Deviation
feature because the user is "locked out" from using CATIA settings relative to
Performance and 3D Accuracy.
The CATIA V5_to_VERICUT Interface (CATV5) now generates the correct bottom
chamfer for a specific DBL CHAMFER tool.
The CATIA V5-to-VERICUT Interface (CATV5) now revolves a specific CATIA V5
Solid of Revolution (SOR) around the correct axis when bringing it into VERICUT.
New feature, Initial Stock Only, is added to the GibbsCAM-to-VERICUT Interface
(GibbsV) to enable specifying which GibbsCam stocks are to be transferred to
VERICUT.
The NX_to_VERICUT Interface (NXV) is enhanced so that NX tap tools are passed to
VERICUT using the VERICUT Tap Tool definition instead of as a sketch profile.
The NX_to_VERICUT Interface (NXV), Assembly Arrangement List feature, is
enhanced so that now the models are written out immediately after the model selection is
made, instead of waiting for the "Output Files" button to be selected.
The NX_to_VERICUT Interface (NXV), file selection box extension filter for adding
programs and subprograms, is now capable of listing multiple file extensions.
The NX_to_VERICUT Interface (NXV) is enhanced to support M, C, and 90 degree
style lathe tool holders.
The NX_to_VERICUT Interface (NXV) now assembles L style lathe tool holders
correctly when passing them to VERICUT.
The NX_to_VERICUT Interface (NXV) no longer passes tools in the NX Machine Tool
View, Unused Items list, to the VERICUT Tool Manager.
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The NX_to_VERICUT Interface (NXV) now creates the tool list correctly when the
Output Tools By option is set to NX Object Name.
The localization files that are used to translate the NX_to_VERICUT Interface (NXV) to
German now includes all NXV options.
The NX_to_VERICUT Interface (NXV) now displays menus correctly for NX7 and
NX7.5 files.
The NX_to_VERICUT Interface (NXV) no longer overwrites the colors specified for
Fixture, Stock, and Design components in the Project Template file.
Tools using quotation marks in the Description field of a tool library file, created using
the NX_to_VERICUT Interface (NXV), now display correctly when the tool library is
brought into VERICUT.
The Pro/E-to-VERICUT Interface (PROEV) is enhanced so that only tools that are
actually used in the manufacturing operation are passed to VERICUT.
A problem preventing the Pro/E-to-VERICUT Interface (PROEV) from passing tools
with Tool Numbers with more than 5 digits is fixed.

G-Code Processing
New macro, BlockSkipNoValue, is added to support machine controls that not support
multiple switches. The Block Skip will always be interpreted as switch 1.
New macros, MotionCWSpiral and MotionCCWSpiral are added to support Spiral
Interpolation options like G2.1 and G3.1 on Mazatrol controls, and G02 and G03 on
Fanuc controls.
The following new macros are added to enable automatically transferring tool data from
Tool Manager to specified control variables.
AutosetToolManCutCom840DVars - Transfers Tool Manager Cutter Compensation
data to the specified control variables.
AutosetToolManLengthVars - Transfers Tool Manager Gage Offset data to the
specified control variables.
AutosetToolManDrvPntVars - Transfers Tool Manager Driven Point offset data to
the specified control variables.
AutosetToolManMisc840DVars - Transfers Tool Manager miscellaneous data (tool
radius, tool type, corner radius, tool ID) to the specified control variables.
The PolarInterpolation macro is enhanced to enable specifying whether to apply polar
interpolation to all motion types or to apply polar interpolation to only linear motions.
New macro, CutterCompNoIntersect, is added to support the Delta Tau G46 Move to
Tangent point with CDC active command.
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The following new general purpose Polar Coordinate macros are added to support the
many variations that Siemens has for Polar Coordinates including the 840D pole
definition with G110, G111, G112.
PolarCoordAngle - Sets the Polar Coordinate Angle.
PolarCoordIncAngle - Increments the Polar Coordinate Angle by the specified
amount.
PolarCoordIncRadius - Increments the Polar Coordinate Radius by the specified
amount.
PolarCoordOnOff - Turns Polar Coordinate mode "on" and "off".
PolarCoordPoleCurPos - Sets the Polar Coordinate Pole position to the current local
axis XYZ position.
PolarCoordPoleIncXYZ - Increments the X, Y, or Z value of the Polar Coordinate
Pole position.
PolarCoordPoleOrigin - Resets the Polar Coordinate Pole position to be (0,0,0).
PolarCoordPoleXYZ - Sets the X, Y, or Z value of the Polar Coordinate Pole
position.
PolarCoordRadius - Sets the Polar Coordinate Radius.
PolarCoordReset - Turns off the Polar Coordinate mode, sets the Polar Coordinate
angle to 0, sets the Polar Coordinate radius to 0, and resets the Polar Coordinate Pole
position to be (0,0,0).
PolarCoordZeroRadius - Specifies what to do if the Polar Coordinate radius is 0.
The Okuma Turning Cycle now processes correctly when the optional blank geometry
feature is used for ID turning.
The Design component now correctly follows the Cut Stock component when using the
ChangeStockTurningAxis macro.
A problem causing the incorrect parsing of a specific command of the type "CALL
$P_PROG[$P_STACK-1] BLOCK USBL TO UEBL", that uses string variables and
string arrays is now fixed.
The RestrictRotaryAxis macro is enhanced to enable specifying an angle at which the
rotary axis angular space is to be divided. The new Override Value option is added to
support the Siemens 840D CYCLE800 subroutine and is only valid for use with macro
WorkingPlane2AbcSolution, types 4 (Use the small value solution for the specified
rotary axis) and 5 (Use the large value solution for the specified rotary axis).
The VERICUT Okuma Turning Cycle now simulates cutting the same way that the part
is cut on the actual machine.
A G81 drill cycle now ignores the motion to the Rapid Level when the Rapid Level is
higher than the Retract Level.
The MotionCWSpiral and MotionCCWSpiral macros now work correctly when a
spiral motion is started from the center of the first spiral.
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The SequenceLoop macro is enhanced to enable passing an Override Text value of
"OFFSET". If the text value is "OFFSET", an incremental offset will be applied to each
sequence loop. The amount of the offset is specified using the WorkCoord macros
(WorkCoordXValue, WorkCoordYValue, …). This offset will be applied as a shift offset
(index 2). Offsets are supported for the 12 axis values (xyzabcuvwa2b2c2).
The CycleMillPocketType macro is enhanced to include a new Override Value option,
4 = Heidenhain Pilot G841.

Machine Simulation
The informational message "Probe stem hit material before the probe tip" is now output
when the probe stem touches the part, instead of the probe "tip".
The MSG PROC in the library sin840d.spf file no longer produces parsing errors when
there is a missing parameter. VERICUT replaces the missing parameter with a default
value of 0.
The tool display is now updated immediately when using the ToolChainMotion macro.
For a specific project file, the machine now positions correctly when the Allow Motion
Beyond Limit feature is unchecked.
After saving an In Process file for a specific project file, and then loading the In Process
file, the macros in the control under Start of Processing Events, Subsystem 1, are no
longer displayed pink and the drilling/boring cycles now drill to the correct depth.
A problem causing a pocket cycle in a specific project file, where the cutter diameter is
the same as the pocket width, to fail in VERICUT, but cut correctly on the actual,
machine is fixed.
False cutter to Fixture collision errors are no longer reported for a specific project file
using the ChangeStockTurningAxis macro.
"Touch" no longer causes a "Turret collided with Cut Stock" error, for a specific project
file, when the components involved are in the Collision Detect list.
When "Allow Motion Beyond Limit" feature, on the Collision and Travel Limits
window: Travel Limits tab, is toggled "off" (unchecked) the machine axis motion will
stop when the machine reaches its axis limit.
The full directory path of the Initialization file is now saved in the control file.
A Tool/Fixture collision, in a specific project file, is no longer missed by VERICUT
when run on a 32 bit computer.
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OptiPath
The VERICUT-OPTIPATH comment record is now working correctly.
The optimized records output by OptiPath for PRO/E APT circle format and, possibly,
for other APT formats which define a circle as a set of GOTO/... points after
"CIRCLE/..." statement is now correct.
The OptiPath Break-up circle feature no longer causes full 360 circle motion in the
optimized file for a specific NC program.

Tool Manager
When using the stand-alone Tool Manager (opened with toolman.bat), the Z Offset
window (right mouse button menu > Shift Component Z) now closes when OK is
selected.
The Alternate Tool feature now remains toggled "on" (checked) for a Reference Tool
after the project file is saved and then re-opened.
The Tool Manager "Alternate" tool feature has been expanded to enable using
"Alternate" holders.
Holder once again appears in the Component Type pull-down list in the Tool Manager,
Search Tool window.
Adding a Holder using the Tool Manager, Milling Tool Wizard no longer outputs error
messages instead of correctly adding the Holder.

VERICUT Reviewer
Opening a VERICUT Reviewer file that resides in a network folder now only requires
that you have read permission to the folder where the .vcreview file resides.
The Reverse view feature in VERICUT Reviewer now works correctly.
Tools are now displayed correctly in all setups when VERICUT Reviewer is started using
the reviewer.bat file.

Verification
VERICUT is enhanced to improve Collision Checking performance when using
VERICUT Solid (.vct) fixture models.
VERICUT is enhanced to output different Fast Feed error messages depending on
whether the motion is in "rapid" mode or in "feed" mode. When in "rapid" mode, the
error message "Fast feed rate removed material with tool ...." will be output. When in
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"feed" mode, the error message "Fast feed exceeded the maximum feed value (val) with
tool ....." will be output.
VERICUT no longer removes sequence numbers outside of the specified range when
renumbering an NC program.
The "Auto-set working directory to current project folder" option on the Preferences
window: Start-up tab is enhanced to set the working directory when opening an In
Process (IP) file.
A specific tool created in V6.2.2 no longer generates false holder collisions when used in
V7.1.4.
VERICUT now correctly finds subroutines when using encrypted control files and
multiple setup project files.
Unexpected VERICUT termination no longer occurs for a specific project file while
drilling sub-spindle stock on centerline caused by incorrect tool loading.
VERICUT is enhanced so that when creating a very large Reviewer file (.vcreview) it
automatically splits the file when it's size exceeds 2 GB.
A problem preventing temp files, created during the creation of reviewer files, from being
automatically deleted when exiting VERICUT is fixed.
The Cut Stock no longer disappears when using Undo after moving the Cut Stock to
another setup, or repositioning the Cut Stock.
The EDM machine no longer continues to cut after the wire is cut for a specific project
file using an Agie 123 control.
The image displayed in the Profile View is now correct for a specific project file.
Tools are now positioned correctly, for a specific project file created in V6.2.2 using the
Tool Change by List feature, when the list is built in V7.1.4.
False "collision between the tool and the cutstock with stop spindle" errors are no longer
output for a specific project file when using a Siemens CYCLE86 retract command.
The Process Cutter Comp. option, "On -Default to Full Radius" is enhanced to retrieve
the radius from an 'insert cutter milling' tool.
Using AutoSave to save an In Process (IP) file, for a specific project file, no longer fails
when the Enable NC Program Review feature in the Properties window is toggled "on"
(checked).
The simulation is now correct for an XZB lathe when Cutter Compensation – On –
Default to Full Radius is being used.
VERICUT is enhanced to provide better performance when running Constant Gouge
Check.
Mate/Align now works correctly for situations where the cut stock was previously rotated
via CSYS.
Holder collision are now reported correctly for situations where the tool assembly has no
cutter.
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Unexpected VERICUT termination no longer occurs when one of the options under View
> Layout > Standard, or one of the corresponding toolbar icons, is selected when no
views are currently displayed in the VERICUT graphics area.
Unexpected VERICUT termination no longer occurs when the Design Points component
in a specific project file is set to be visible in both views (Workpiece and Machine/Cut
Stock).
Unexpected VERICUT termination no longer occurs when a specific project file created
in V7.0 is run in V7.1.4.
A probing operation, in a specific project file created in V6.2.2, now works correctly
when run in V7.1.4.
The Animation Speed Slider setting no longer influences whether or not a Holder/Stock
Collision error is output in a specific project file.
False collision errors are no longer output for a specific inserted drill when exiting the
hole during a drill cycle.
A problem causing a bad display of a specific broaching operation when after cutting the
part, you do a Zoom followed by a Refine Display, or by varying the Animation Speed
Slider setting, is fixed.
VERICUT now displays a trace on the part surface, rather than drawing a polygon
rendition of the knife path, for a specific project file that is cutting with an ultrasonic
knife.
Logfile and logger entries that were cleared prior to saving an In-Process file (IP file) are
no longer restored in the IP file.
Unexpected VERICUT termination no longer occurs when using the MDI window to
move an axis for a new project file containing only a machine and the library sin840d
control.
VERICUT no longer displays a "Cannot open tool library file" error message when the
VcProject file being opened does not have a tool library file (.tls ) referenced in it.
Unexpected VERICUT termination no longer occurs when the first G76 turning cycle
call is encountered, in a specific project file, when run on a 64 bit computer.
The cutstock display, in a Workpiece View, is no longer affected by the Animation Slider
setting.
False Holder collisions are no longer reported for a specific project file using a unique
inserted milling tool.
The display of a specific tool, in a specific project files, no longer flattens when the
ConnectToCompName macro is called many times.
Component Visibility is added to the Workpiece View right mouse button menu. Only
components that appear in the branch below the Attach component will appear in the
component list.
VERICUT now supports the Okuma style syntax of #VTOFD[$] for override values that
are an element of an array. More specifically, as part of an override expression,
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VERICUT now supports the "$" feature within variables as long as the $ character is not
the first character (on the sin840D control, many system variables begin with the "$"
character). The "$" is substituted with the input value.

Miscellaneous
The library hei530.ctl control is enhanced to support:
the Heidenhain PLANE AXIAL A171.2604 B9.7916 TURN FMAX SEQ+
command.
the Heid_Feedrate macro.
the Heid_XAxisIncreMotion and Heid_YAxisIncreMotion macros.
the CYCL DEF 207 command now uses the SetCycleTapFeedMode macro.
The following library Mazak controls (maz640mpro.ctl, maz640mtpro.ctl,
mazak_e650h_2000u_640mpro.ctl, mazatrol_matrix_m.ctl, mazatrol_matrix_t.ctl and
mazatrol_matrix_integrex_e.ctl) now have the correct SetCyclePartSurface override
value.
The library hascnc.ctl control is enhanced to include the macro SetCyclePartSurface in
the Events section of the control to avoid "rapid" errors when processing certain G-Code
commands such as G83.
The library haas_minimill.ctl and hascnc.ctl controls are enhanced to include the macro
AutosetTableAxisVars for G-Code commands G10, L2 and L20 and in the Events
section of he control.
Support is added for simulating an angle milling head on an industrial robot.
A problem causing the TDM Interface to generate certain tools incorrectly on 64 bit
computers is fixed.
In NC Program Review the tool path trace for helical motion is now displayed correctly.
In NC Program Review and NC Program Preview, the Current Line color pallet has been
replaced by a Circular Motion color pallet. The selected color is used for circular and
helical motions. The Current Line is now represented by thicker line width.
A problem preventing the Setup Plan, Select View window from opening when the Setup
Plan image is used as a picture in a VERICUT Report template is fixed.
The CGTech Post-Processor is enhanced to enable accessing variables in VERICUT
directly from the post-processor.
The following new topics are added to the Notes about Special Topics section in the
CGTech Help Library.
Notes about Okuma Parsing Enhancements
Notes about Stock Component Orientation
Notes about using Post-Processors in VERICUT
Notes about using Industrial Robots in VERICUT
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Czech language versions of getting_started.jpg (Zaciname.pdf) and project_tree.pdf
(StromProjektu.pdf) are available in the top level of the V7.1.4 Installer and also in the
\hhelp\ directory of the VERICUT installation.

New Macros in V7.1.4
The following new macros are added for V7.1.4:
AccudyneCourse
AccudyneCourseDist
AutosetToolManCutCom840DVars
AutosetToolManCutComVars
AutosetToolManDrvPnt840DVars
AutosetToolManDrvPntVars
AutosetToolManLength840DVars
AutosetToolManLengthVars
AutosetToolManMisc840DVars
BlockSkipNoValue
ChangeStockTurningAxis
ComputerRoundoffAdjOnOff
CutterCompNoIntersect
CutterCompValueCombo
DuplicateLabelCheckOnOff
FastenerDrill
FastenerDrillAndInsert
FastenerDrillAndInsertFastenerIDNum
FastenerDrillAndInsertFastenerIDText
FastenerInsert
FastenerInsertFastenerIDNum
FastenerInsertFastenerIDText
FastenerRemove
FastenerSetCounterSink
FastenerSetDiameter
FastenerSetLocationIDNum
FastenerSetLocationIDText
FastenerSetMaterial
FastenerSetStackCount
FastenerSetThickness
FastenerSetType
Heid_PilotCycleMillDepth
Heid_PilotCycleMillEndSequence
Heid_PilotCycleMillFeedrate
Heid_PilotCycleMillOverlap
Heid_PilotCycleMillOverrun
Heid_PilotCycleMillOversizeX
Heid_PilotCycleMillOversizeZ
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Heid_PilotCycleMillRetractionPlane
MotionCCWSpiral
MotionCWSpiral
PolarCoordAngle
PolarCoordIncAngle
PolarCoordIncRadius
PolarCoordOnOff
PolarCoordPoleCurPos
PolarCoordPoleIncXYZ
PolarCoordPoleOrigin
PolarCoordPoleXYZ
PolarCoordRadius
PolarCoordReset
PolarCoordZeroRadius
RPY2Ijk
SetCycleTapFeedMode
SetMinCollisionBreakDown
SetPostVariables
ToolLengthCompValueCombo
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Macros not yet included in the documentation
AccudyneCourse
Function — TAPE LAYING
Status — ACTIVE
Comment — Added V7.1.4
Valid Inputs — Value
value = the new course number
This macro is passed the new course number for an Accudyne Tape machine.

NOTE: Since the ADDS and CUTS variables (which are used to determines when
tows are turned on and off), are based on the distance from the start of the course, and the
distance value is based on the total distance within the file, we must track the changing of
the course to mark the starting distance for the current course.

AccudyneCourseDist
Function — TAPE LAYING
Status — ACTIVE
Comment — Added V7.1.4
Valid Inputs — Value
value = the total distance of all courses within this file
This macro processes the course distance value for an Accudyne Tape machine. The
value passed is the total distance of all courses within this file.
The ADDS and CUTS variables are used to determines when tows are turned on and off.
This, however, is based on this distance from the start of the course. The starting distance
is subtracted from the input distance, and is used with ADDS and CUTS variables to
determine when tows are added and removed.

ChangeStockTurningAxis
Function — MISCELLANEOUS
Status — ACTIVE
Comment — Added V7.1.4
Valid Inputs — Text
text = the name of the stock component
The macro is used to do turning operations with a changing turning axis. It should be
called directly before each call to the B2AxisMachineMotion macro. This macro will
most likely become obsolete in V7.2 when an enhanced solution is implemented. (7235)
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Heid_PilotCycleMillDepth
Function — MISCELLANEOUS
Status — ACTIVE
Comment — Added V7.1.4
Valid Inputs — Value
value = the maximum milling depth
This macro is used to specify the maximum milling depth (infeed in the working plane)
for the Heidenhain Pilot 4290 G841 rough milling cycle.

Heid_PilotCycleMillEndSequence
Function — MISCELLANEOUS
Status — ACTIVE
Comment — Added V7.1.4
Valid Inputs — Value
value = ending block number
This macro is used to specify the block number representing the sequence end for the
Heidenhain Pilot 4290 G841 rough milling cycle.

Heid_PilotCycleMillFeedrate
Function — MISCELLANEOUS
Status — ACTIVE
Comment — Added V7.1.4
Valid Inputs — Value
value = infeed feedrate
This macro is used to specify the infeed feedrate for the Heidenhain Pilot 4290 G841
rough milling cycle. The default value is the active feedrate.

Heid_PilotCycleMillOverlap
Function — MISCELLANEOUS
Status — ACTIVE
Comment — Added V7.1.4
Valid Inputs — Value
value = minimum overlap factor
This macro is used to specify the minimum overlap factor, which defines the overlap of
milling paths, for the Heidenhain Pilot 4290 G841 rough milling cycle. The default value
is 0.5.
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Heid_PilotCycleMillOverrun
Function — MISCELLANEOUS
Status — ACTIVE
Comment — Added V7.1.4
Valid Inputs — Value
value = the overrun factor
This macro is used to specify the overrun factor, which defines the distance by which the
tool should pass the outside radius of the workpiece, for the Heidenhain Pilot 4290 G841
rough milling cycle. The default value is 0.5. Overrun = Overrun Factor * milling
diameter.

Heid_PilotCycleMillOversizeX
Function — MISCELLANEOUS
Status — ACTIVE
Comment — Added V7.1.4
Valid Inputs — Value
value = the oversize value in X
This macro is used to specify the oversize value in the X direction for the Heidenhain
Pilot 4290 G841 rough milling cycle.

Heid_PilotCycleMillOversizeZ
Function — MISCELLANEOUS
Status — ACTIVE
Comment — Added V7.1.4
Valid Inputs — Value
value = the oversize value in Z
This macro is used to specify the oversize value in the Z direction for the Heidenhain
Pilot 4290 G841 rough milling cycle.

Heid_PilotCycleMillRetractionPlane
Function — MISCELLANEOUS
Status — ACTIVE
Comment — Added V7.1.4
Valid Inputs — Text
text = the retraction plane
XY plane = the retraction position in the Z direction
YZ plane = the retraction position in the X direction (diameter)
This macro is used to specify the retraction plane for the Heidenhain Pilot 4290 G841
rough milling cycle. The default is back to the starting position.
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Heid_PilotCycleMillStartSequence
Function — MISCELLANEOUS
Status — ACTIVE
Comment — Added V7.1.4
Valid Inputs — Value
value = starting block number
This macro is used to specify the block number representing the sequence start for the
Heidenhain Pilot 4290 G841 rough milling cycle.

RPY2Ijk
Function — MOTION
Status — ACTIVE
Comment — Added V7.1.4
Valid Inputs — Value
0 = turns off the conversion
1 = turns on the conversion
This macro is used when the tool orientation vector is programmed in the part coordinate
system as RPY angles instead of the more common IJK components of a vector. When
this macro is called with Override Value of 1, the input RPY angles representing the tool
orientation vector are converted to the corresponding IJK components of the tool
orientation vector. The resultant vector can then be transformed by the Rotation Plane
matrix if necessary (see the ApplyRotationPlaneWithIjk2Abc macro) before the
machine's ABC angles are resolved. Calling this macro with an Override Value of 0,
turns "off" the conversion. This macro is added to support the Siemens 840D ORIWKS
and ORIMKS commands.
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VERICUT 7.1.5 Interim Release
Release Notes
October 21, 2011

VERICUT Version 7.1.5 is available for all supported Windows platforms.
V 7.1.5 contains everything described above for V7.1.4, plus the following additional
fixes/enhancements.

CAM Interfaces
The CATIA V5_to_VERICUT Interface (CATV5) now passes a specific tap tool, created
in CATIA, to VERICUT.
The CATIA V5_to_VERICUT Interface (CATV5) is enhanced to correctly handle tool
profile sketches revolved around the X-axis.
The CATIA V5_to_VERICUT Interface (CATV5) is enhanced to enable milling tools,
specified by a CATProduct/CATPart, to optionally have their gage point defined by the
overall length of the parametric cutter. Use the environment variable "set
CGTECH_GAGE_IS_PARAMETRIC_LENGTH=Yes" to trigger this behavior.
The GibbsCAM-to-VERICUT Interface (GibbsV) now orients the program zero correctly
for turning NC programs.
The Mastercam-to-VERICUT Interface (MCAMV) now displays the attach component
name and populates the attach component pull-down list correctly after the Setup
Template is changed.
The Mastercam-to-VERICUT Interface (MCAMV) now correctly populates all Attach
components when the specified Project Template file has multiple Attach components.
The NX_to_VERICUT Interface (NXV) now allows you to review your geometry
selections after outputting the models (Output Files or Output and Run). Picking one of
the geometry type icons (Part, Stock/Blank, and Fixture/Check) highlights the selected
models associated with that geometry type in the graphics area.
The NX_to_VERICUT Interface (NXV) now creates NX defined turning inserts with the
correct cutting angle. It is also enhanced to create NX Turn Holder Styles: J-Style and 0
Degrees correctly.
The NX_to_VERICUT Interface (NXV) now creates NX defined step drills with the
correct diameter and flute length.
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The NX_to_VERICUT Interface (NXV) now correctly attaches models to the selected
Attach component when Attach components are named anything other than "Attach".
The NX_to_VERICUT Interface (NXV) for NX5, NX6, and NX7, are enhanced to
enable displaying both the NX Toolpath Verification icon and the NXV interface icons,
like they do in NX7.5.
The NX_to_VERICUT Interface (NXV) now supports NX8 on supported 32 and 64 bit
computers.
The NX_to_VERICUT Interface (NXV) now runs VERICUT regardless of the directory
where VERICUT was installed.
The Run VERICUT, Output Files, and Output and Run buttons now display in Japanese
characters in a Japanese version of the NX-to-VERICUT Interface (NXV).
The Pro/E-to-VERICUT Interface (PROEV) now allows you to keep the original Stock in
the Stock selection panel.
The Pro/E-to-VERICUT Interface (PROEV) is enhanced to enable transferring the
Holder names from Pro/E Tool Assemblies to Tool Manager in VERICUT.
The Pro/E-to-VERICUT Interface (PROEV) now uses the new OPS file logic so that the
VcTmp file now uses the new tag (AttachName).
The Pro/E-to-VERICUT Interface (PROEV) is enhanced to enable saving the Operations
List after removing the operations that he does not want to run and to get the "removed"
operations back into the Operations List if needed.

G-Code Processing
VERICUT no longer takes a very long time to perform collision detection when
processing a specific 3-axis NC program.
A new word format, Type: Special, Subtype: EXECSTRING is added to support the
Siemens command EXECSTRING.
The Siemens840DSubSequenceStart macro now works correctly in a specific control
configuration.
NC Program Preview no longer outputs false "word not defined" and parsing errors.
False Errors are no longer output for G84 tapping cycles when the Initial Level is below
the Retract Level.

Machine Simulation
Machine models are now displayed correctly when changing from a Machine/Cut Stock
view, to a Workpiece view, and then back to a Machine/Cut Stock view, when OpenGL
is active.
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Unexpected VERICUT termination no longer occurs during motion after a specific turret
tool is loaded.
Support is added for Siemens 840D STRLEN, SUBSTR, and MATCH string operations.
Performance is enhanced for project files that use water jet cutters to cut very large parts.
A problem causing the incorrect parsing of the AXIS syntax: Aches = (Z1) is fixed.

OptiPath
OptiPath Constant Surface Speed optimization now outputs RPM changes correctly.

Tool Manager
Tool Manager information no longer changes, after the tool library file is saved, for tools
added using the Edit > Search Tool feature and then changing the Tool ID and
Description.
The "Mate" constraint type can now be used to position a tap to the bottom of a holder.
A Csys can now be positioned by selecting the top of a tap tool.
Unexpected VERICUT termination no longer occurs when using Tool Manager's File >
Save feature when the target /path/filename for the tool library file no longer exists.
The first Csys created using the Construct tab, during a stand-alone Tool Manager
session, now creates the Csys correctly using the default Primary Axis and Secondary
Axis vector settings.
The following fields are now populated correctly when positioning a Csys by
highlighting the field and selecting a point in the graphics area during a stand-alone Tool
Manager session.
The Location > Position field in the Configure Coordinate System window.
The From and To fields on the Configure Coordinate System window: Translate tab.
The Center of Rotation field on the Configure Coordinate System window: Rotate
tab.
A specific profile cutter is now displayed correctly when revolved in VERICUT.
Gage Offset field values in Tool Manager are now correctly updated to reflect the new
position when Shift Component Z with Automatic Gage Offset Z is used to adjust holder
to cutter stickout length and auto-adjust the gage offset value.
A specific STEP cutter profile is now correctly imported into VERICUT.
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Verification
The Cut Stock no longer disappears when you select Undo after moving the Cut Stock.
A Group Data by Tool option is added in the Tool Summary Table window enabling
you to display Tool Summary Table Data grouped per tool in VERICUT Reports.
A "Tap cycle feed advance ..." error no longer results from using a tap defined with
different units than the units of the project file (for example a metric tap in an Inch
project file).
False Holder collisions are no longer reported during helical motions in a specific project
file.
Calculate Min. Cutter Extension now retains the largest minimum height value
encountered when a tool used multiple times.
Material removal, with the part in the main spindle, is now correct after doing a Rewind.
The initial display of a cylinder model, while it is being defined, is improved so that it
more closely resembles a cylinder.
In a Profile view, you can now pick points around the outside profile of a lathe insert for
measurements when the holder is visible.
A specific project file, using ConnectToCompName macros in subroutines that are called
during toolpath Reset, no longer outputs false virtual memory errors.
Unexpected VERICUT termination no longer occurs when a specific subroutine, using an
undefined array variable, is called.
Coordinate system definition is enhanced to enable locating a Coordinate System at the
center of a tapped hole using the Construct tab > Origin > Circle feature.
The display is now correct after rotating a view, in a specific project file, when FastMill
is active.
Error messages are now displayed in the NC Program Preview message logger.
Machine models are now displayed correctly, when switching from a Machine/Cut Stock
view to Workpiece view and then back to Machine/Cut Stock view.
Machine models are now displayed correctly, when OpenGL is active after OpenGL has
been toggled on/off a few times.
Cycle time is now computed correctly for a tool in a specific project file that is using
Constant Surface Speed.
Cylindrical Interpolation now works correctly for a specific project file that uses a
machine with a virtual Y-axis.
A specific project file now opens successfully, on a 32 bit computer, without running out
of memory.
Material is now removed correctly for a specific double-concave milling tool profile.

59

Unexpected VERICUT termination no longer occurs when using the G-Code Processing
window: Utilities > Find feature with a specific control file.
The Animation Speed Slider setting no longer affects whether a holder/stock collision is
reported for a specific project file.
Circular motions, in a specific In Process file, no longer produce false gouges.
A specific imported STEP cutter profile now produces correct material removal when
used in VERICUT.
Material removal when processing a G76 cycle on Vertical Turning Lathe is now correct.

Miscellaneous
A new environment variable, CGTECH_AD_REPORT_LIMIT, is added to enable
specifying the maximum number of errors that are to be displayed in an AUTO-DIFF
report.
The library Sin840D control is modified to default to the C2 rotary axis for SPOS
commands.
The library Sin840D control is modified to process the Siemens TURN function
correctly.
The library Sin840D control is modified so that the variable $TC_DP6 now gets the value
of the tool radius by default, rather than tool diameter, when the SetDynamicVars macro
is called with Override Text: "CurToolDiam $TC_DP6" in "G-Code Processing, Events,
Start Of Processing".
VERICUT Drill and Fastener Simulation now displays the projected models for
countersunk holes with the inner ring radius equal to the radius of the hole, and a larger
outer ring radius.
A cutter, created from a specific STEP profile, now displays correctly in VERICUT.
The ability to add a "Save All" button to VERICUT Customizer is added. A command
line option must be used to specify the "save to" file name. Thus on VERIBOOK's
command line, an option something like,
"customizer_save_project_to=mypath\myfile.vcproject" must be used. Then when
VERICUT Customizer is invoked, the "save-to" file name is used when a "Save", or
"Save All", action is made.
VERICUT Reviewer no longer outputs "false" Warnings that were not output in
VERICUT during the original simulation, when opening the Reviewer file.
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New Macros in V7.1.5
The following new macro is added for V7.1.5:
AAxisMotionVirtualAdjust

Macros not yet included in the documentation
AAxisMotionVirtualAdjust
Function — MOTION
Status — Active
Comment — Added V7.1.5
Valid Inputs — Value
This macro subtracts the polar angle defined by the current Y, Z axis point, and the EI
Virtual Center, from the input value, and then calls the AAxisMotion macro. The EI
Virtual Center is determined by the current X axis value and the curve defined using the
EIVirtualSpinPoint macro.

AccudyneCourse
Function — TAPE LAYING
Status — ACTIVE
Comment — Added V7.1.4
Valid Inputs — Value
value = the new course number
This macro is passed the new course number for an Accudyne Tape machine. .

AccudyneCourseDist
Function — TAPE LAYING
Status — ACTIVE
Comment — Added V7.1.4
Valid Inputs — Value
value = the total distance of all courses within this file
This macro processes the course distance value for an Accudyne Tape machine. The
value passed is the total distance of all courses within this file.
The ADDS and CUTS variables are used to determine when tows are turned on and off.
This, however, is based on this distance from the start of the course. The starting distance
is subtracted from the input distance, and is used with ADDS and CUTS variables to
determine when tows are added and removed.
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AlternateTool
Function — TOOLING
Status — Active
Comment — Added V7.1
Valid Inputs — Value
0 = the alternate cutter is blanked and the primary cutter is displayed. (Default)
1 = the alternate cutter is displayed and the primary cutter is blanked.
This macro is used to turn on/off the display of alternate cutters. When AlternateTool is
called with an Override Value of 0, the alternate cutter is blanked and the primary cutter
is displayed and used by VERICUT. An Override Value of 0 is the default condition.
When called with an Override Value of 1, and the current tool has an alternate cutter,
then the primary cutter is blanked and the alternate cutter is displayed and used in
VERICUT.

ChangeStockTurningAxis
Function — MISCELLANEOUS
Status — ACTIVE
Comment — Added V7.1.4
Valid Inputs — Text
text = the name of the stock component
This macro is used to do turning operations with a changing turning axis. It should be
called directly before each call to the B2AxisMachineMotion macro. This macro will
most likely become obsolete in V7.2 when an enhanced solution is implemented. (7235)

Heid_PilotCycleMillDepth
Function — MISCELLANEOUS
Status — ACTIVE
Comment — Added V7.1.4
Valid Inputs — Value
value = the maximum milling depth
This macro is used to specify the maximum milling depth (infeed in the working plane)
for the Heidenhain Pilot 4290 G841 rough milling cycle.

62

Heid_PilotCycleMillEndSequence
Function — MISCELLANEOUS
Status — ACTIVE
Comment — Added V7.1.4
Valid Inputs — Value
value = ending block number
This macro is used to specify the block number representing the sequence end for the
Heidenhain Pilot 4290 G841 rough milling cycle.

Heid_PilotCycleMillFeedrate
Function — MISCELLANEOUS
Status — ACTIVE
Comment — Added V7.1.4
Valid Inputs — Value
value = infeed feedrate
This macro is used to specify the infeed feedrate for the Heidenhain Pilot 4290 G841
rough milling cycle. The default value is the active feedrate.

Heid_PilotCycleMillOverlap
Function — MISCELLANEOUS
Status — ACTIVE
Comment — Added V7.1.4
Valid Inputs — Value
value = minimum overlap factor
This macro is used to specify the minimum overlap factor, which defines the overlap of
milling paths, for the Heidenhain Pilot 4290 G841 rough milling cycle. The default value
is 0.5.

Heid_PilotCycleMillOverrun
Function — MISCELLANEOUS
Status — ACTIVE
Comment — Added V7.1.4
Valid Inputs — Value
value = the overrun factor
This macro is used to specify the overrun factor, which defines the distance by which the
tool should pass the outside radius of the workpiece, for the Heidenhain Pilot 4290 G841
rough milling cycle. The default value is 0.5. Overrun = Overrun Factor * milling
diameter.
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Heid_PilotCycleMillOversizeX
Function — MISCELLANEOUS
Status — ACTIVE
Comment — Added V7.1.4
Valid Inputs — Value
value = the oversize value in X
This macro is used to specify the oversize value in the X direction for the Heidenhain
Pilot 4290 G841 rough milling cycle.

Heid_PilotCycleMillOversizeZ
Function — MISCELLANEOUS
Status — ACTIVE
Comment — Added V7.1.4
Valid Inputs — Value
value = the oversize value in Z
This macro is used to specify the oversize value in the Z direction for the Heidenhain
Pilot 4290 G841 rough milling cycle.

Heid_PilotCycleMillRetractionPlane
Function — MISCELLANEOUS
Status — ACTIVE
Comment — Added V7.1.4
Valid Inputs — Text
text = the retraction plane
XY plane = the retraction position in the Z direction
YZ plane = the retraction position in the X direction (diameter)
This macro is used to specify the retraction plane for the Heidenhain Pilot 4290 G841
rough milling cycle. The default is back to the starting position.

Heid_PilotCycleMillStartSequence
Function — MISCELLANEOUS
Status — ACTIVE
Comment — Added V7.1.4
Valid Inputs — Value
value = starting block number
This macro is used to specify the block number representing the sequence start for the
Heidenhain Pilot 4290 G841 rough milling cycle.
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RPY2Ijk
Function — MOTION
Status — ACTIVE
Comment — Added V7.1.4
Valid Inputs — Value
0 = turns off the conversion
1 = turns on the conversion
This macro is used when the tool orientation vector is programmed in the part coordinate
system as RPY angles instead of the more common IJK components of a vector. When
this macro is called with Override Value of 1, the input RPY angles representing the tool
orientation vector are converted to the corresponding IJK components of the tool
orientation vector. The resultant vector can then be transformed by the Rotation Plane
matrix if necessary (see the ApplyRotationPlaneWithIjk2Abc macro) before the
machine's ABC angles are resolved. Calling this macro with an Override Value of 0,
turns "off" the conversion. This macro is added to support the Siemens 840D ORIWKS
and ORIMKS commands.
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VERICUT 7.1.6 Interim Release
Release Notes
April 13, 2012

VERICUT Version 7.1.6 is available for all supported Windows platforms.
V 7.1.6 contains everything described above for V7.1.5, plus the following additional
fixes/enhancements.

CAD Model Interface
The CAD Model Interface now supports importing STEP files that have 2 byte character
names.
With the implementation of Spatial R22, a specific STEP file can now be successfully
loaded into VERICUT.
The CAD Model Interface now supports importing STEP files that have "French
characters" in the directory path.

CAM Interfaces
The CATIA V5_to_VERICUT Interface (CATV5) is enhanced so that all instances of all
CATParts within selected CATProducts are transferred and are marked as visible or
hidden, so that the picture that first appears in VERICUT matches that displayed in
CATIA. Model names are now transferred to VERICUT, in addition to their file names.
The CATIA V5_to_VERICUT Interface (CATV5) no longer deletes the Fixture models
in the Setup Template when no fixture models have been specified. The following rules
will be followed:
If a Setup Template component has models, and the corresponding CATV interface
component has no models, then in the new VERICUT project the component will
retain its Setup Template models.
If a Setup Template component has models, and the corresponding CATV interface
component also has models (block/cone/cylinder are considered models), then for this
component the Setup Template models are deleted and the CATV interface models
used in the new VERICUT project.
The CATIA V5_to_VERICUT Interface (CATV5) now automatically sets Design, Stock
and/or Fixtures when running the CATV on a new CatProcess that references a CGR.
Success depends on the CATPart or CATProduct used to create the CGR being present in
the same folder.
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The CATIA V5_to_VERICUT Interface (CATV5) no longer changes the operation
names in the CATProcess. The supplemented names will appear in the VcTmp files, and
thus in VERICUT. The supplemented names will also appear in CATV5's dialog and it is
left to the user to match these up with the duplicate operation names in the CATIA tree.
They will appear in the same order in the CATV5 dialog as they appear in the CATIA
tree.
The CATIA V5_to_VERICUT Interface (CATV5) now recognizes a more generic
environment variable, CGTECH_LATHE_HOLDERS_AS_CATPARTS, to provide the
same functionality as the customer specific environment variable
CGTECH_AT_ALSTOM.
"CGTECH_LATHE_HOLDERS_AS_CATPARTS=Yes" triggers two different
behaviors, both pertaining to turning tools only.
1) CATV5 expects a folder of sub-folders containing CATParts of turning tool
holders. This parent folder is defined by another environment variable
"CGTECH_CATV_LATHE_HOLDER_PARENT_FOLDER" and each holder
will be at "…\holder_name\holder_name.CATPart".
2) The gage point for each turning tool holder will be defined by a CATIA axis
system called "Tool Holder Axis System".
The GibbsCAM-to-VERICUT Interface (GibbsV) now correctly transfers GibbsCAM
mill/turn data to VERICUT.
The GibbsCAM-to-VERICUT Interface (GibbsV) now correctly assigns the correct stock
component to the correct Attach components for projects using multiple Attach
components.
The Mastercam-to-VERICUT Interface (MCAMV) is enhanced to support Mastercam
X6 on both 32 and 64 bit computers.
The Mastercam-to-VERICUT Interface (MCAMV) now correctly exports Mastercam X5
models to a Horizontal Mill/Turn in VERICUT.
A new tag, ProevMaterialRemovalMode is added to the Pro/E-to-VERICUT Interface
(PROEV) preferences file.
If ProevMaterialRemovalMode is "0" (Default), then PROEV will move the "Insert
Here" right before the first Material Removal Feature.
If ProevMaterialRemovalMode is "1", then PROEV will move the "Insert Here" right
after the operation currently being processed.
If the ProevMaterialRemovalMode tag does not exist in the preference file, then the
default value is used.
A new "Stock CSYS" choice list is added to the Pro/E-to-VERICUT Interface (PROEV)
to enable specifying a Stock Transition CSYS when appending a VCProject file.
If "Stock CSYS" is set to "None," then the current transition method is used.
If "Stock CSYS" is set to a valid CSYS, then a new transition method uses the
difference between the "Attach CSYS" and the "Stock CSYS."
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The Pro/E-to-VERICUT Interface (PROEV) now creates the stock correctly for situations
where there are more than 1 operation and ProevMaterialRemovalMode is set to "1".
The Pro/E-to-VERICUT Interface (PROEV) is enhanced to enable using Pro/E
parameters to specify the Gage Point in Tool Manager. The tool's gage point and
orientation will be calculated as follows:
If a "TIP" csys and a "SPINDLE_CONTROL_POINT" csys are defined, then their
values will be used to compute the gage point and orientation.
If a "TIP" csys and a "TOOL_ATTACH_POINT" csys are defined, then their values
will be used to compute the gage point and orientation.
If "GAUGE_X_LENGTH" or "GAUGE_Y_LENGTH" or "GAUGE_Z_LENGTH"
are defined, then the respective value will be used as X/Y/Z coordinate for the gage
point.
If "LENGTH" is defined, then its value will be used as the Z gage point.
The Pro/E-to-VERICUT Interface (PROEV) is enhanced so that directory path
persistence is supported in all file selection windows, meaning that when you re-open a
file selection window, it will return to the directory that was last visited. The last
directory visited for each file selection window is stored in the preference file when
exiting PROEV. The following new preference tags are now written to the preference
file.
ProevOutDirPath - Output Directory tag
ProevProjectPath – Project Template tag
ProevSetupPath – Setup Template tag
ProevTLibOverridePath – Tool Library Override tag
ProevTpPath – Tool Path tag
ProevSubPath – Subroutine tag
The Pro/E-to-VERICUT Interface (PROEV) no longer creates the Stock, Fixture and
Design models for all Attach components when using a VERICUT Template that
contains two, or more, Attach components. Models are now only created for the Attach
components selected.
The Pro/E-to-VERICUT Interface (PROEV) is enhanced to support probing tools. Only
tools with Tool Type set to "LOLLIPOP" and VERICUT_TYPE set to "PROBING" are
processed as probing tools. If these two conditions are met, PROEV will create a probing
tool in Tool Manager using the parameters specified in the Pro/E Tool Setup window.
The Pro/E-to-VERICUT Interface (PROEV) now positions Stock and Design
components under the correct attach component for a specific Pro/E file with multiple
setups and multiple Attach components.
The Pro/E-to-VERICUT Interface (PROEV) now outputs an informational message when
VERICUT fails to launch because the specified template file cannot be found.
The Pro/E-to-VERICUT Interface (PROEV) now outputs all specified tools for a specific
Pro/E file with multiple operations.
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The Pro/E-to-VERICUT Interface (PROEV) is enhanced to support SubRegisters for
Work Offsets.
The Pro/E-to-VERICUT Interface (PROEV) now creates Stock of the correct thickness
when using ProevMaterialRemovalMode set to 1.

G-Code Processing
A false collision is no longer reported for a specific project file when polar interpolation
is active. The false collision was reported because the polar move goes through the
centerline, or passes very close to it. New polar interpolation logic is introduced to better
handle these types of situations.
In V7.1.6, you must call the new PolarNewLogicOnOff macro with an Override Value
=1, during Start of Processing, to activate the new polar interpolation logic. In V7.2 the
new polar interpolation logic will become the default.
A specific project file starting with a G505 Work Offset and others dynamically written,
no longer deletes all Work Offsets from the Project Tree when a Reset is done after any
processing has taken place.
Heid TNC530 DEP CT (Departure Cutter Tangent) now works correctly for a specific
project file.
A new macro, SiemensCondColon, is added to support the ":" character in all 3 valid
uses with an 840D control:
as a frame link operator
as an inverse word with labels
as a sequence number (configure the ":" character as Type: conditional with Sub
Type: SiemensCondColon)
Siemens 840D FRAME variable values are now updated correctly upon Reset when a
project file created in an earlier version of VERICUT is opened in V7.1.
Siemens 840D LINK FRAME ":" character now works correctly.
Integers are now correctly rounded up immediately on Siemens 840d.
A new macro, CutterCompTBD, is added to support G46 on Traub TX8 controls. G46
is an auto detection cutter compensation direction. It looks ahead to see the path and then
looks at the tool tip type to determine if it should be cutter compensation left or cutter
compensation right.

Machine Simulation
Machine views are now correctly updated at Tool Changes.
Using the Touch macro no longer causes false collision errors when the components
involved are in the Collision Detect list.
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When using an encrypted machine file, many false control processing errors no longer
occur when opening a specific VcProject file.

OptiPath
A problem causing invalid Volume Removal Rate warnings to be output when running an
optimized file, for a specific project file, is fixed.
If the G-Code command (VERICUT-OPTIPATH off) is used and is not followed by a
(VERICUT-OPTIPATH on) somewhere in the G code, OptiPath no longer remains off
after a Reset.
OptiPath circle breakup no longer causes full 360 circles in the optimized file.
For CATIA APT and UG CLS NC program files, if the Circle Feedrate option is “Breakup", it is now automatically reset internally to "Optimize" and a warning is issued. The
Circle Feedrate "Break-up" option does not support CATIA APT and UG CLS circle
formats.
OptiPath no longer outputs two blocks in the optimized file for each block containing a
G40 when OptiPath is turned On/Off using VERICUT-OPTIPATH comment records in a
specific NC program file.
Unexpected VERICUT termination no longer occurs while using OptiPath Learn Mode
in cases where existing OptiPath records are not updated and the Record Cutting
Conditions option in the Properties window is turned on.
OptiPath no longer comments out FEDRAT statements in the optimized NC program file
when optimizing a specific APT NC program when the Graphs window is open and the
Cutting Conditions Graph is active.
OptiPath no longer "restores" the previous RAPID feedrate, for APT NC programs using
a VERICUT-OPTIPATH comment record to turn off OptiPath, when the NC program is
already in a RAPID state.

Tool Manager
A problem preventing VERICUT to open STEP tool files is fixed by Spatial
Technologies in version R22.
Unexpected VERICUT termination no longer occurs while creating a Tool Manager
Report when a tool has more than nine inserts.

Verification
Unexpected VERICUT Termination no longer occurs for a specific project file when
"Build tool List" is selected.
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Nested MODIN commands in Okuma OSP controls now work correctly.
Material removal is now correct for a specific project file that makes complex 5-axis cuts
using concave and hollow tools, regardless of the Animation Speed Slider setting.
Changing the Animation Speed Slider setting no longer causes false holder collisions for
a specific project file that makes complex 5-axis cuts using concave and hollow tools.
Unexpected VERICUT termination no longer occurs for a specific project file processing
a G3 code using a tool insert defined as a rectangle with a radius exactly half the width.
The time required to process collision checking between large VERICUT Solid fixture
models and the active cutter is greatly reduced.
The Down Arrow key now works correctly for navigation through menus.
The Touch macro no longer outputs a false Holder/Cut stock collision error when using a
holder as the “touch” component.
When the Check Cutting Limits option, on the Tool Manager Configure Setup menu:
Motion tab, is toggled "on", Warnings are now correctly output after doing a Reset.
Internal server folders are now correctly displayed in VERICUT file selection windows
on 64 bit Windows 7 computers.
The delay experienced when opening a file using the new file selection box on Windows
Vista and Windows 7 computers is fixed so the old file selection box should no longer be
used.
A false collision between the stock and the steady rest no longer occurs for a specific
project file with the implementation of new polar interpolation logic described above
under G-Code Processing.
The directory path to a control's initialization file is now saved when you save the
control.
The simulation of a specific project file no longer "hangs" while doing a lot of collision
calculations with the Animation Speed Slider set to 100%.
The Near Miss values in the Project Tree: Check Collisions Between menu are now
correctly set when a new project file is opened.
A new Word Format setting, Conditionals, is added to the NC Program Colors window to
support words defined as Type: Conditional, such as X, Y, and Z words in Siemens 840d
controls, during syntax checking.
The temporary files that VERICUT uses for Undo and Redo are now deleted when
exiting the VERICUT session. Only the temporary files associated with the VERICUT
session being closed are deleted.
Values containing a decimal point can now be used to initialize Number type User
Defined variables, Frames, or Frame Arrays.
The length restriction has been removed for VERICUT file filters so that all of the filters
in the list can be seen.
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Material removal is now correct for a specific profile cutter with a non-cutting center
regardless of the position of the Animation Speed Slider.
Saving an In-Process file in the middle of simulating a specific project file, then loading
the In-Process file and continue simulating to the end, now produces the same result as
simulating the original project file to the end.
A false collision is no longer output for a specific water jet tool used in a specific project
file.
Unexpected VERICUT termination no longer occurs after importing a setup from a
specific project file into the same project file, renaming the setup, and then doing a Reset.
VERICUT Log and Report values are now correct for a specific project file using
Calculate Minimum (Min.) Cutter Extension.
VERICUT no longer reports a false collision when using a specific tool in a specific
project file, when the Animation Speed Slider is set at 100%.
X-Caliper Volume measurement is no longer different for block, cylinder and cone
models after the project file is saved.
A specific project file, using an encrypted control file, no longer outputs false variable
related errors when simulating with the NC Program window open.
Simulating a specific project file using a specific profile insert cutter, now displays
material removal correctly in all views.
When using a project file that has had the tool library file moved to a different folder,
reselecting the relocated tool library file now loads correctly in Tool Manager.
When simulating a spiral motion in a specific project file, processing speed is now
constant regardless of the Animation Speed Slider setting.
An APT DISPLY/ statement is now interpreted correctly when the $ continuation
character is inside of the statement's single quotes.
When a project file is successfully created and loaded into VERICUT from a CAM
interface, it will immediately be saved so that it is visible in File Summary.
Unexpected VERICUT termination no longer occurs after using AutoSave to save an InProcess file at the end of each Setup, then merging the In-Process file into the original
Setup, and re-simulating with the same AutoSave settings.
In a specific project file, the machine and tool changer are now correctly restored upon
Reset.
All Frames are now correctly reset upon using Reset Model when using a specific
Siemens 840d control.
Mouse Pick Indicator highlight color now works correctly on Windows 7 computers.
X-Caliper now works correctly for measuring Rapid plunge errors in a specific project
file using Distance/Angle from a plane to a point.
A circular motion in a specific project file, with Cutter Compensation active, is now
correct.
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The Feature/History database no longer gets corrupted when simulating a specific project
file with the Animation Speed Slider is set at 100% or is in the Skip Motion range.
The stock block dimensions shown in a VERICUT Report are now the same as the actual
stock block dimensions used in a specific project file.
Simulating a specific project file that uses a tool with overlapping inserts no longer
causes the VERICUT session to "hang".
Unexpected VERICUT termination no longer occurs when using copy/paste in the GCode Processing window for a specific control file.
The simulation of a specific project file no longer stops at "Optional Stop" codes that
appear in the NC program before the specified Start At location.
Holder collisions are now detected and reported when using an ultrasonic knife.
The VERICUT session no longer "hangs" when opening a specific project file saved in
V7.1.2.
Unexpected VERICUT termination no longer occurs when simulating a specific project
file that uses CAD Tool tools with "spun" models that have been incorrectly specified as
an "Insert Cutter".

Miscellaneous
The TURN word in the library sin840d control is modified to more accurately represent
the real behavior on the machine.
A problem causing Uninstall to start immediately, when started using the Start menu,
instead of displaying the Uninstall panel with Cancel and Uninstall buttons is fixed.
The library Heidenhain 530 iTNC control is enhanced to support PLANE AXIAL.
The library Sin840d.spf now resets to the Absolute/Incremental mode that was in effect
prior to calling the CYCLE86 subroutine.
The library Sin840d.spf now resets to the Feed mode that was in effect prior to calling the
CYCLE84 subroutine.
The T_IsNumber word is now spelled correctly in the library Sin840d.def file.
The library Siemens 840d control has been enhanced as follows:
The RPY2ijk macro is removed from the ORIMKS and ORIWKS words.
The RPY2ijk macro is associated to the ORIEULER and ORIRPY words.
A license server is no longer needed to run VERICUT Reviewer.
Unexpected VERICUT Reviewer termination no longer occurs when the project file that
the reviewer file created from does not have a Logfile.
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The following new function is added:
MINDEX(str1, str2)
This is a string processing function used in Siemens Sin840D programs. It returns the
index of the first occurrence of any character of str2 in string str1. The returned index
is counted from 1. A return value of 0 indicates that no character of str2 is present in
str1. For more details see the 840D Programming Manual.
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New Macros in V7.1.6
The following new macro is added for V7.1.6:
AddModelReplaceParent
CutterCompTBD
CycleTurnIgnoreDescent
CycleTurnNextLine
CycleTurnThreadPassCount
Ijk2AbcInput
Ijk2AbcPartRot
Ijk2AbcSolution
Ijk2AbcToolOrient
PolarNewLogicOnOff
SetPostActive
SiemensCompToVcAxisMapping
WorkingPlaneRelative
WorkOffsetRelative

Macros not yet included in the documentation
AAxisMotionVirtualAdjust
Function — MOTION
Status — Active
Comment — Added V7.1.5
Valid Inputs — Value
This macro subtracts the polar angle defined by the current Y, Z axis point, and the EI
Virtual Center, from the input value, and then calls the AAxisMotion macro. The EI
Virtual Center is determined by the current X axis value and the curve defined using the
EIVirtualSpinPoint macro.

AccudyneCourse
Function — TAPE LAYING
Status — ACTIVE
Comment — Added V7.1.4
Valid Inputs — Value
value = the new course number
This macro is passed the new course number for an Accudyne Tape machine. .
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AccudyneCourseDist
Function — TAPE LAYING
Status — ACTIVE
Comment — Added V7.1.4
Valid Inputs — Value
value = the total distance of all courses within this file
This macro processes the course distance value for an Accudyne Tape machine. The
value passed is the total distance of all courses within this file.
The ADDS and CUTS variables are used to determine when tows are turned on and off.
This, however, is based on this distance from the start of the course. The starting distance
is subtracted from the input distance, and is used with ADDS and CUTS variables to
determine when tows are added and removed.

AddModelReplaceParent
Function — MACRO_MISC
Status — ACTIVE
Comment — Added V7.1.6
Valid Inputs — text
Text: FromComp_name
ToComp_name
This macro is used to move models from one component to another component.
FromComp_name specifies original parent where the model resides and ToComp_name
specifies the destination component. The exchange of parents is possible only for
models which have been added to the parent component using AddModelToComponent
macro. All native models remain intact. The model attributes are not changed during
transition. To avoid model motion at transition operation apply also the
AddModelSetRelComponent macro.

AlternateTool
Function — TOOLING
Status — Active
Comment — Added V7.1
Valid Inputs — Value
0 = the alternate cutter is blanked and the primary cutter is displayed. (Default)
1 = the alternate cutter is displayed and the primary cutter is blanked.
This macro is used to turn on/off the display of alternate cutters. When AlternateTool is
called with an Override Value of 0, the alternate cutter is blanked and the primary cutter
is displayed and used by VERICUT. An Override Value of 0 is the default condition.
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When called with an Override Value of 1 and the current tool has an alternate cutter, then
the primary cutter is blanked and the alternate cutter is displayed and used in VERICUT.

ChangeStockTurningAxis
Function — MISCELLANEOUS
Status — ACTIVE
Comment — Added V7.1.4
Valid Inputs — Text
text = the name of the stock component
This macro is used to do turning operations with a changing turning axis. It should be
called directly before each call to the B2AxisMachineMotion macro. This macro will
most likely become obsolete in V7.2 when an enhanced solution is implemented. (7235)

CutterCompTBD
Function — CUTTER_COMPENSATION
Status — ACTIVE
Comment — Added V7.1.6
Valid Inputs — None
This macro is used to simulate a G46 command in a Traub TX8 control. The G46
command is an auto detection cutter compensation direction. It looks ahead to see the
path and then looks at the tool tip type to determine if it should be cutter comp left or
cutter comp right.
This macro turns Cutter Compensation On but does not set the left/right direction until
there are two motions in the queue. Then if these two motions form a left turn VERICUT
sets the compensation direction to "left", and if the two motions form a right turn
VERICUT sets the cutter compensation direction to "right".

CycleTurnIgnoreDescent
Function — TURNING CYCLES
Status — ACTIVE
Comment — Added V7.1.6
Valid Inputs — Value
0 = Off
1 = On
This macro turns OFF (0) or ON (1) the rough turning ignore-descent internal flag. This
macro is modal and the default is OFF (0). When turned ON, rough turning cycle motions
are ignored for any portion of the contour that descends.
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CycleTurnNextLine
Function — TURNING CYCLES
Status — ACTIVE
Comment — Added V7.1.6
Valid Inputs — Value
0 = Off
1 = On
This macro turns OFF (0) or ON (1) the rough turning next-line internal flag. This macro
is modal and the default is OFF (0). When turned ON, the simulation will continue from
the next statement right after the rough turning cycle statement.

CycleTurnThreadPassCount
Function — TURNING CYCLES
Status — ACTIVE
Comment — Added V7.1.6
Valid Inputs — Value
Specifies the maximum number of passes to execute for the thread cycle.

Heid_PilotCycleMillDepth
Function — MISCELLANEOUS
Status — ACTIVE
Comment — Added V7.1.4
Valid Inputs — Value
value = the maximum milling depth
This macro is used to specify the maximum milling depth (infeed in the working plane)
for the Heidenhain Pilot 4290 G841 rough milling cycle.

Heid_PilotCycleMillEndSequence
Function — MISCELLANEOUS
Status — ACTIVE
Comment — Added V7.1.4
Valid Inputs — Value
value = ending block number
This macro is used to specify the block number representing the sequence end for the
Heidenhain Pilot 4290 G841 rough milling cycle.
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Heid_PilotCycleMillFeedrate
Function — MISCELLANEOUS
Status — ACTIVE
Comment — Added V7.1.4
Valid Inputs — Value
value = infeed feedrate
This macro is used to specify the infeed feedrate for the Heidenhain Pilot 4290 G841
rough milling cycle. The default value is the active feedrate.

Heid_PilotCycleMillOverlap
Function — MISCELLANEOUS
Status — ACTIVE
Comment — Added V7.1.4
Valid Inputs — Value
value = minimum overlap factor
This macro is used to specify the minimum overlap factor, which defines the overlap of
milling paths, for the Heidenhain Pilot 4290 G841 rough milling cycle. The default value
is 0.5.

Heid_PilotCycleMillOverrun
Function — MISCELLANEOUS
Status — ACTIVE
Comment — Added V7.1.4
Valid Inputs — Value
value = the overrun factor
This macro is used to specify the overrun factor, which defines the distance by which the
tool should pass the outside radius of the workpiece, for the Heidenhain Pilot 4290 G841
rough milling cycle. The default value is 0.5. Overrun = Overrun Factor * milling
diameter.

Heid_PilotCycleMillOversizeX
Function — MISCELLANEOUS
Status — ACTIVE
Comment — Added V7.1.4
Valid Inputs — Value
value = the oversize value in X
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This macro is used to specify the oversize value in the X direction for the Heidenhain
Pilot 4290 G841 rough milling cycle.

Heid_PilotCycleMillOversizeZ
Function — MISCELLANEOUS
Status — ACTIVE
Comment — Added V7.1.4
Valid Inputs — Value
value = the oversize value in Z
This macro is used to specify the oversize value in the Z direction for the Heidenhain
Pilot 4290 G841 rough milling cycle.

Heid_PilotCycleMillRetractionPlane
Function — MISCELLANEOUS
Status — ACTIVE
Comment — Added V7.1.4
Valid Inputs — Text
text = the retraction plane
XY plane = the retraction position in the Z direction
YZ plane = the retraction position in the X direction (diameter)
This macro is used to specify the retraction plane for the Heidenhain Pilot 4290 G841
rough milling cycle. The default is back to the starting position.

Heid_PilotCycleMillStartSequence
Function — MISCELLANEOUS
Status — ACTIVE
Comment — Added V7.1.4
Valid Inputs — Value
value = starting block number
This macro is used to specify the block number representing the sequence start for the
Heidenhain Pilot 4290 G841 rough milling cycle.

Ijk2AbcInput
Function — MISCELLANEOUS
Status — ACTIVE
Comments — Added V7.1.6
Valid Inputs — Text
IJK = Tool Axis Vector (default)
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ABC = Virtual Angles, where the orientation is specified as a rotation about X,
then Y, then Z
CBA = Virtual Angles, where the orientation is specified as a rotation about X,
then the rotated Y, and then the rotated Z
This specifies the type of input that will be used to define the orientation for the Ijk2Abc
conversion. Initially, this was implemented for Ijk2AbcType = 99.
To input the IJK Tool Axis Vector, call IVector, JVector, KVector, or IJKVector.
To input the Virtual Angles, call IjkAAxisMotion, IjkBAxisMotion, or IjkCAxisMotion.
The Type 99 conversion also supports orienting the tool. If the Input type is IJK, then
IVector2, JVector2, KVector2, or IJKVector2 macros should be called to define the X
Axis Vector.

Ijk2AbcPartRot
Function — MISCELLANEOUS
Status — ACTIVE
Comments — Added V7.1.6
Valid Inputs — Value
1 = The input orientation specifies the Tools orientation relative to the Part
0 = The input orientation specifies the Tools orientation relative to the Base
This attribute is specific to the Ijk2Abc conversion Type =99.

Ijk2AbcToolOrient
Function — MISCELLANEOUS
Status — ACTIVE
Comments — Added V7.1.6
Valid Inputs — Value
1 = Orient the Tool if possible (default)
0 = Do not orient the Tool
This attribute is specific to the Ijk2Abc conversion Type =99. Typically, only the Tool
Axis Vector is given, and the Ijk2Abc conversion Type = 99 can be used to calculate the
2 real angles to achieve the specified orientation. If a XAxisVector is also specified, or if
Virtual angles are specified, and if the Tool has a C orientation axis, then the Ijk2Abc
conversion Type = 99, can also be used to calculate the 3 real angles to achieve the
specified orientation. Given the proper input, and the necessary machine kinematics, this
attribute turns on and off this feature.
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PolarNewLogicOn/Off
Function — CYLINDRICAL/POLAR
Status — ACTIVE
Comment — Added V7.1.6
Valid Inputs — Value
New and improved logic has been implemented to better support Polar Interpolation.
Prior to V7.2, the default is to use the old logic. In V7.2 the default will be to use the
new logic. A value of zero causes the old logic to be executed. A value of 1 causes the
new logic to be executed. No other changes are needed in the interface to implement the
new logic.

RPY2Ijk
Function — MOTION
Status — ACTIVE
Comment — Added V7.1.4
Valid Inputs — Value
0 = turns off the conversion
1 = turns on the conversion
This macro is used when the tool orientation vector is programmed in the part coordinate
system as RPY angles instead of the more common IJK components of a vector. When
this macro is called with Override Value of 1, the input RPY angles representing the tool
orientation vector are converted to the corresponding IJK components of the tool
orientation vector. The resultant vector can then be transformed by the Rotation Plane
matrix if necessary (see the ApplyRotationPlaneWithIjk2Abc macro) before the
machine's ABC angles are resolved. Calling this macro with an Override Value of 0 turns
"off" the conversion. This macro is added to support the Siemens 840D ORIWKS and
ORIMKS commands.
SiemensCompToVcAxisMapping
Function — MACRO_MAPPING
Status — ACTIVE
Comment — Added V7.1.6
Valid Inputs — OV = 0 Off, 1 = On
This macro is used to create a mapping table where all machine components which are
configured with the “Motion Axis” field set will use a component name as the axis name
in a part program. Internally these components names are linked to VERICUT axes
names (X Y Z A B C U V Z A2 B2 C2). When this mapping is applied, the Siemens
Sin840D specific preprocessor should be used to correctly handle motion commands and
axis names used in the part program. See the SetPreProcessorType macro.
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WorkingPlaneRelative
Function — WORK OFFSETS
Status — ACTIVE
Comment —Added V7.1.6
Valid Inputs — none
This macro is equivalent to SiemensPAROT macro and is designed to process Working
Plane definition similar to the Sin840D PAROT command for non-Siemens controls, like
Heidenhain.
WorkOffsetRelative
Function — WORK OFFSETS
Status — ACTIVE
Comment — Added V7.1.6
Valid Inputs — Value
This macro is used to activate new logic to process the Sin840D PAROT command.
When the Override Value is set to 1, the new logic is applied. If the Override Value is set
to 0, then the old PAROT logic is applied. The new logic is similar to the old logic except
that it is enhanced to better handle more cases of machine kinematics that previously not
handled correctly.
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